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1 Best Practices for FlexusL

After purchasing a FlexusL instance, you can build environments, websites, or
applications on it. This section summarizes the best practices of using application
images to create FlexusL instances.

Table 1-1 Best practices

Item Description

Migrating
Servers
Using Server
Migration
Service
(SMS)

Use Server Migration Service (SMS) to migrate other cloud
servers to Huawei Cloud FlexusL instances in the same region or
across regions.

Building a
WordPress
Website

Use the WordPress application image to quickly set up a
website.

Managing
Servers
Using the BT
Panel

Use the BT panel application image to quickly deploy and
manage your servers.

Analyzing
Website
Data Using
the Matomo
Application
Image

Use the Matomo application image to quickly deploy servers
and analyze website data.

Visualizing
Docker
Managemen
t Using
Portainer

Use the Portainer application image to quickly deploy servers
and visualize Docker management.
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Item Description

Using GitLab
to Manage
Teams and
Projects

Use the GitLab application image to quickly deploy servers and
manage teams and projects.

Using
PrestaShop
to Build an
E-Commerce
Website

Use the Prestashop application image to set up an e-commerce
website.

Using Odoo
to Build an
ERP System

Use the Odoo application image to quickly deploy servers and
build enterprise ERP.

Using
Superset to
Obtain Data
from MySQL
Databases
for Analysis

Use the Superset application image to quickly deploy servers
and obtain data from the MySQL data source for analysis.

Using
Nextcloud to
Build an
Enterprise
Web Disk
System

Use the Nextcloud application image to quickly deploy servers
and build an enterprise network disk system.

Pushing PC
Desktop
Streams to
SRS Using
OBS

Use the SRS application image to quickly deploy servers and use
OBS to push streams from a local PC to SRS.
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2 Migrating Servers Using Server
Migration Service (SMS)

Application Scenarios
This section describes how to use Server Migration Service (SMS) to migrate other
cloud servers to Huawei Cloud FlexusL instances in the same region or across
regions.

Precautions
● Once the migration starts, do not perform operations on the FlexusL

instances, including but not limited to stopping the instances, changing the
OS, or reinstalling the OS. Otherwise, the migration will be interrupted or fail.

● If you want to migrate incremental data after the full migration is complete,
do not reinstall or change the OS for the FlexusL instances, or the migration
will fail.

Constraints
● Only x86 servers can be migrated to FlexusL instances.
● SMS migrates entire servers. It cannot only migrate system or data disks of

servers.
● Only servers with one data disk can be migrated. The paired FlexusL instances

must have system and data disks at least as large as the source servers.

For more information, see SMS Precautions and SMS Constraints.
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Resource Planning and Costs
Resour
ce

Data
Planning

Description Cost

Source
server

Server name:
source-server
OS: CentOS
7.9

The source server can be
in Huawei Cloud, another
cloud platform, or an on-
premises environment.

If the source server has
no EIP bound, you need
to configure one for the
source server. You need
to pay for the EIP.

Target
server

Server name:
destination_se
rver
OS:
Huawei Cloud
EulerOS 2.0

The target server is a
Huawei FlexusL instance.

You need to pay for the
FlexusL instance.

SMS - SMS is available for free. You need to pay for the
pay-per-use migration
resources (including EVS
disks, EVS snapshots, and
traffic) used during the
migration. For details,
see SMS Billing.

 

Process
Procedure Description

Making
Preparations

Prepare accounts, obtain required permissions, and
prepare source and target servers.

Step 1 Installing
and Starting the
Agent on the
Source Server

Install and start the Agent on the source server. To start
the Agent, you must enter the AK/SK pair of the Huawei
Cloud account the FlexusL instance belongs to. After the
Agent is started, it reports information about the source
server to SMS.

Step 2: Configuring
the Target Server
on the SMS
Console

Configure the target server which will receive data
migrated from the source server.

Step 3: Starting
the Migration

Start the migration to replicate all data from the source
server to the target server. The replication speed depends
on the outbound bandwidth of the source server or the
inbound bandwidth of the target server, whichever is
smaller.
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Procedure Description

Step 4: Viewing
the Migration
Result

Check whether the source server is successfully migrated,
and install the one-click password reset plug-ins and the
HSS Agent on the target server.

Step 5: Creating a
Private Image and
Changing the OS
of the FlexusL
instance

Create a private image for the FlexusL instance and use
the image to change the OS for the instance. In this way,
the OS name of the FlexusL instance can be displayed in
the instance card, and reinstalling the OS for the FlexusL
instance will not roll back its OS to that before the
migration.

 

Making Preparations

Prepare accounts, obtain required permissions, and prepare source and target
servers.

1. Register a HUAWEI ID and enable Huawei Cloud services.

NO TE

Real-name authentication is required for migration to regions within the Chinese
mainland.

2. Obtain required permissions for your HUAWEI ID.
If you use an HUAWEI ID for migration, you have the required permissions by
default. If you use an IAM user for migration, you need to obtain the required
permissions. For more information, see Creating a User Group and
Assigning Permissions.

3. Obtain an AK/SK pair for your target account.
The AK/SK pair will be used for authentication during the migration. To learn
how to obtain an AK/SK pair, see How Do I Obtain an AK/SK Pair for an
Account?

CA UTION

SMS does not support AK/SK-based authentication for federated users (virtual
users).

4. Note the username and password for logging in to the source server.
If your source server is not in Huawei Cloud, note the username and password
of the source server. The username and password are required when you
install the one-click password reset plug-ins on the target server after the
migration is complete. If you forget the username and password, the plug-ins
installation process will be complex.

5. Confirm that the source server OS is supported by SMS.
– See Supported Windows OSs or Supported Linux OSs.
– A target server must run the same type of OS as the source server.
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6. Ensure that the following network requirements are met:

a. The source server can connect to the Huawei Cloud API Gateway over
TCP port 443. For more information, see Connecting Source Servers to
Huawei Cloud API Gateway. For details about how to control traffic into
and out of a security group, see Adding a Security Group Rule.

NO TE

It is recommended that all outbound ports on the source server be opened.

b. The source server can connect to the target server. For more information,
see Connecting Source Servers to Target Servers.
In this practice, EIP is used for connection. You need to purchase and
configure EIPs for both the source and target servers. A FlexusL instance
has an EIP bound by default.

c. The following ports are enabled in the security group of the target server
to allow traffic to these ports:

▪ Windows: TCP ports 8899, 8900, and 22

▪ Linux: TCP port 22 for file-level migration, and ports 8900 and 22 for
block-level migration

For details about how to control traffic into and out of a security group,
see Adding a Security Group Rule.

CA UTION

● For security purposes, you are advised to only allow traffic from the
source servers over these ports.

● The firewall of the target server must allow traffic to these ports.

7. Ensure that the following source server requirements are met:
Available Space
– Windows: at least 320 MB of available space on a partition not smaller

than 600 MB, and at least 40 MB of available space on a partition
smaller than 600 MB

– Linux: at least 200 MB of available space on the root partition
Source Environment
– The system time of the source server must be consistent with the local

standard time to avoid Agent registration failures.
– If the source server runs Linux, rsync must be installed on it. You can run

the rsync -v command to check whether rsync is installed.
If it is not, install it by running the following command:

▪ CentOS: yum -y install rsync

▪ Ubuntu: apt-get -y install rsync

▪ Debian: apt-get -y install rsync
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▪ SUSE: zypper install rsync

▪ Other distributions: Refer to the official website documentation.

NO TE

rsync comes preinstalled on most distributions by default.

Step 1 Installing and Starting the Agent on the Source Server
● If the source server runs a Linux OS, see Installing the Agent on Linux.
● If the source server runs a Windows OS, see Installing the Agent on

Windows.

FAQ

1. If an error message indicating that rsync is not installed is displayed when you
install Agent on the Linux source server, install rsync based on Installing
Rsync and then reinstall the Agent.

2. If the following error message is displayed, check whether the access key is
correctly entered or deleted.

Figure 2-1 Error message
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Figure 2-2 Access key

Step 2: Configuring the Target Server on the SMS Console
1. Log in to the SMS console using the Huawei Cloud account that owns the

FlexusL instance and choose Servers on the left.
2. On the Servers page, locate the source server to be migrated and click

Configure.
After step 1 is complete, you can see the source server record on the Servers
page of the SMS console.

3. Configure the basic settings.
Retain the default settings on this page.
For details about the parameters, see Configuring the Target Server.
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4. Configure the target server and click Next: Confirm in the lower right corner.
– Region: Select the region where the purchased FlexusL instance is

located.
– Server: Select Use existing and choose the purchased FlexusL instance.

▪ Only servers with one data disk can be migrated. The paired FlexusL
instances must have system and data disks at least as large as the
source servers.

▪ The target server must run the same type of OS as the source server.

▪ The security group of the target server must be correctly configured.
It must be configured to allow access on TCP ports 8899, 8900, and
22 for a Windows migration, or on port 22 for a Linux migration.
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If the following information is displayed when you perform this step, allow
traffic over the prompted port, refresh the page, and repeat this step.

5. On the Confirm page, confirm the information and click Save or Save and
Start.
– If you select Save, read the migration checklist carefully and click OK.

Then start the migration.
– If you select Save and Start, read the migration checklist carefully and

click OK. The migration starts automatically. View the migration status
and details.
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Step 3: Starting the Migration
1. Log in to the SMS console using the Huawei Cloud account that owns the

FlexusL instance and choose Servers on the left.
2. On the Servers page, locate the source server to be migrated and click Start

in the Operation column.
Alternatively, select the server to be migrated and click Start above the server
list.

3. After the migration starts, click the name of the source server to view the
migration status and details.

4. Check whether the Status changes to Finished. If it changes, the target server
has been launched, and the migration is complete.

5. (Optional) If incremental data is generated on the source server after the full
migration is complete, synchronize the incremental data from the source
server to the target server.

NO TE

If you want to migrate incremental data after the full migration is complete, do not
reinstall or change the OS for the target server, or the migration will fail.
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Step 4: Viewing the Migration Result
1. Check the OS on the FlexusL instance.

Click Remote Login in the FlexusL instance card. If the OS and kernel
information of the source server is displayed, the migration is successful.
Enter the username and password of the source server to log in to the FlexusL
instance.

2. (Optional) Install the one-click password reset plug-in on the FlexusL
instance.
If your source server was not created from a Huawei Cloud image, install the
one-click password reset plug-in on the FlexusL instance. With the plug-in,
you can reset your instance password.
– If you know the password of your source server, install the plug-in by

referring to Installing the One-Click Password Reset Plug-in.
– If you forget the password of your source server, install the plug-in by

referring to Setting the Password and Installing the One-Click
Password Plug-in.

3. (Optional) Check the HSS service status.
– If your FlexusL instance does not contain the HSS service, skip this step.
– If your FlexusL instance contains the HSS service, but the service is not

enabled, enable HSS by referring to What Do I Do If HSS Is Not Started
After I Use a Private Image to Create a FlexusL Instance or Change
the OS of an Instance?

Figure 2-3 HSS Unprotected status
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Step 5: Creating a Private Image and Changing the OS of the FlexusL
instance

After the migration is complete, the original OS name (Huawei Cloud EulerOS 2.0)
is still displayed in the FlexusL instance card, as shown in figure Figure 2-4. If you
choose to reinstall the OS for the FlexusL instance after the migration is complete,
the OS will actually be rolled back to the original OS Huawei Cloud EulerOS 2.0
rather than CentOS 7.9, and the OS data migrated from the source server will be
lost.

Create a private image for the FlexusL instance. Then use the image to change the
OS for the instance. After the OS is changed, the above two problems can be
solved.

NO TICE

If the OS is changed, incremental data on the source server cannot be
synchronized. Ensure that no incremental data needs to be synchronized before
changing the OS.

Figure 2-4 Image name of the FlexusL instance

1. Log in to IMS console, choose Create Image, and configure the following
parameters:

– Region: Retain the default value.

– Type: Retain the default value.

– Image Type: Retain the default value.

– Source: Select the FlexusL instance.

– Name: Enter an image name that is easy to identify, for example,
CentOS 7.9_source-server-image.

– Agreement: Read the agreements and select the Agreement option.
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2. Click Next, confirm the information, and click Submit.
3. Go back to the FlexusL console, click the FlexusL instance, and choose

Change OS in the upper right corner.

4. Configure the parameters for changing the OS and click Submit.
– Select the private image CentOS 7.9_source-server-image created in 1.
– Stop the instance first or select Stop server on the Change OS page.
– Read and agree to the agreements.
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5. Check whether the image name on the console is changed.
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3 Using Windows Server to Set Up a
Cross-Border E-Commerce Store

3.1 Overview

Application Scenario
You can use FlexusL instances to manage multiple e-commerce stores. The
following uses Amazon stores as an example to show how to manage multiple e-
commerce stores on FlexusL instances.

Solution Architecture
On the Amazon platform, a seller cannot manage multiple accounts from the
same public IP address. This can raise red flags and may lead to account
suspension or other consequences.

With FlexusL instances, you can log in to different stores from the same host
without worrying about account issues.
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You can also use the same FlexusL instance to manage stores on other e-
commerce platforms.

Resource Planning and Costs

Table 3-1 Resource planning and costs

Resou
rce

Type Description Cost

Cloud
server

● vCPUs: 2
● Memory: 2

GiB

FlexusL instances are easy to provision
and manage. In this example, three
FlexusL instances are created, each with 2
vCPUs and 2 GiB memory. You can select
proper FlexusL instance flavors based on
service requirements. The FlexusL instance
names are MyShop_1, MyShop_2, and
MyShop_3, respectively.

You
need
to pay
for
resour
ces
packed
in the
Flexus
L
instanc
es.
Windo
ws
private
images
are
free.

EIP Automatically
assigned

An EIP can be used for Internet access. By
default, one fixed EIP is assigned to a
FlexusL instance.

Data
disk

10 GiB Data disks are used to store data except
the operating system. They are like drive
D, drive E, and drive F in a PC.

CBR 70 GiB Cloud Backup and Recovery (CBR) can
back up data in system and data disks of
FlexusL instances and restore data if
instances fail.
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Resou
rce

Type Description Cost

HSS Host security Host Security Service (HSS) is designed to
improve the overall security of FlexusX
instances. It helps you eliminate risks and
defend against intrusions and web page
tampering. There are also advanced
protection and security operations
functions available to help you easily
detect and handle threats.

Image Windows Server
2019

Windows Server 2019 is used.

 

3.2 Procedure

Process
Procedure Description

Preparations Upload the Windows Server 2019 private image created
from the Windows Server 2019 image to the IMS console so
that you can select the Windows Server 2019 private image
when purchasing FlexusL instances.

Step 1: Purchase
FlexusL
Instances

Purchase a FlexusL instance and select the Windows Server
2019 private image.

Step 2:
Configure
Security Groups

Configure inbound rules for a security group to ensure that
the FlexusL instance can be accessed.

Step 3: Log In to
a FlexusL
Instance Server

Set a password and log in to the FlexusL instance server.

Step 4: Remove
the Session Time
Limit

Set the session time and remove the session time limit to
avoid repeated logins due to session timeout.

Step 5: Open
Stores

After the preceding steps are complete, you have obtained a
complete Windows Server FlexusL instance with a fixed EIP
bound. You can create accounts, and open and manage
stores on e-commerce websites.

 

Preparations
To use the Windows Server 2019 image, create a private image from it on the IMS
console first.
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● If your image format is VMDK, VHD, QCOW2, VHDX, QED, VDI, QCOW, or
ZVHD, see Creating a Windows System Disk Image from an External
Image File.

● If your image format is ISO, see Creating a Windows System Disk Image
from an ISO File.

● If your image format is RAW or ZVHD2, see Quickly Importing an Image
File.

NO TICE

Images are regional resources. FlexusL instances only can use private images that
are in the same region as them. Ensure that the image is in the same region as
the FlexusL instance.

Step 1: Purchase FlexusL Instances
1. Log in to the FlexusL console.

2. Click Buy FlexusL.

3. Configure parameters required for purchasing a FlexusL instance.

Parame
ter

Example Description

Region CN-Hong
Kong

For low network latency and quick resource access,
select the region nearest to your target users. After
a FlexusL instance is created, the region cannot be
changed. Exercise caution when selecting a region.
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Parame
ter

Example Description

Image Windows
Server
2019

In the private image list, select the Windows Server
2019 private image which is in the same region
(CN-Hong Kong) as the instance and has been
uploaded to the IMS console.

Instanc
e
Specific
ations

2 vCPUs | 2
GiB
memory
and 60 GiB
system disk

Select instance specifications as required.

Instanc
e Name

MyShop_1 Customize an instance name that is easy to
identify, for example, MyShop_1, MyShop_2, and
MyShop_3.

(Option
al)
Associa
ted
Services

● Data
disk: 10
GiB

● Host
security

● Cloud
backup
vault: 70
GiB

You can bundle any of the services to your FlexusL
instances as needed: EVS, HSS (basic edition), and
CBR.

Require
d
Duratio
n

● 1 month
● Enabling

auto-
renew

The minimum duration of a purchase is one month
and the maximum duration is three years.
Auto-renew is enabled by default, which means
the purchased FlexusL instances will be
automatically renewed before they expire. If you
do not enable auto-renew during the purchase
process, you can still enable it later after the
instances are created. Monthly subscription allows
you to renew the subscription for one month every
time. The number of renewal times is not limited.
For more information about auto-renewal rules,
see Auto-Renewal Rules.

Quantit
y

3 Set the number of FlexusL instances to be
purchased, for example, three in this example.

 
4. Click Buy Now.

On the displayed page, confirm the order details, read and select the
agreement, and click Submit.

5. Select a payment method and complete the payment.
6. Go back to the FlexusL console and view the purchased FlexusL instance.
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7. Hover the pointer over a resource card, click  next to the instance name,
and change it to MyShop_1, MyShop_2, and MyShop_3, respectively.

Step 2: Configure Security Groups
Configure inbound rules for security groups to ensure that the FlexusL instance
can be accessed.

1. Log in to the console and click a resource card to go to the instance details
page.

2. In the navigation pane on the left, choose Cloud Servers and then click the
server name.

3. On the Security Groups tab, click Add Rule. In the displayed dialog box, add
rules displayed in the following figure and click OK.
The following figure only displays common rules. You can add more rules as
needed.
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Table 3-2 Security group rules

Priorit
y

Actio
n

Type Protocol
& Port

Source Description

1 Allow IPv4 TCP: 80 0.0.0.0/0 Allows HTTP traffic to
FlexusL instances.

1 Allow IPv4 TCP: 443 0.0.0.0/0 Allows HTTPS traffic to
FlexusL instances.

 

Step 3: Log In to a FlexusL Instance Server

For Windows FlexusL instances, the administrator username is Administrator and
there is no default password. Set a password before logging in to the server.

1. Enable Batch operation, select Select all, and click Reset Password.

2. Set a new password for the FlexusL instance servers and click OK.

If you reset the password for running servers, the password change is applied
only after the next restart. Select Auto Restart. After the password is reset,
the server status becomes Restarting. Wait until the status changes to
Running and go to the next step.

3. In the resource card, click Remote Login to remotely log in to the cloud
server using VNC.

4. Click Ctrl+Alt+Del in the upper left corner to unlock the desktop.

Follow the instructions to enter the password set in step 2 and press Enter.
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Step 4: Remove the Session Time Limit
A session is a sequence of uninterrupted requests and responses between a user
and a server. Session timeout occurs when a user does not perform any action
within a specified period and the session of the user is terminated. Once the
session times out, you need to log in to the FlexusL instance server again. This
section describes how to remove the session time limit.

1. In the search box at the lower left corner of the page, search for RUN.
2. Enter gpedit.msc in the RUN dialog box and click OK.
3. In the Local Group Policy Editor window, choose Computer Configuration >

Administrative Templates > Windows Components > Remote Desktop
Services > Remote Desktop Session Host > Session Time Limits, and
double-click Set time limit for disconnected sessions in the right pane.

4. In the displayed dialog box, select Enabled and set End a disconnected
session to Never. Click OK.
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5. In the Local Group Policy Editor window, double-click Set time limit for
active but idle Remote Desktop Services sessions in the right pane.

6. In the displayed dialog box, select Enabled and set Idle session limit to
Never. Click OK.
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Step 5: Open Stores
Now you have obtained a Windows Server FlexusL instance with a fixed EIP
bound. You can create accounts, and open and manage stores on e-commerce
websites.

When running e-commerce stores, you may need to upload your local files to
cloud servers. For details, see How Do I Upload Files to My ECS (The method
also applies to uploading files to FlexusL instances).
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4 Building a WordPress Website

4.1 Overview

Applicable Scenario
WordPress is an enterprise-level open-source content management system. It is
usually used for enterprise website setup, cross-border e-commerce, and personal
blog building. The WordPress application image uses Ubuntu 22.04 and is
deployed using Docker. The Nginx, MySQL, phpMyAdmin, and Docker have been
preconfigured in the image. You can use this application image to quickly set up a
website.

Resource Planning and Costs
This practice uses the following resource planning as an example. You can adjust it
as required.

Resource Configuration Description

Cloud server ● vCPUs: 2
● Memory: 2 GiB

Select appropriate instance
specifications based on your service
requirements.

Image WordPress Select the WordPress application
image.

Security group Inbound rule:
● Protocol: TCP
● Port: 9001,3306
● Source IP: 0.0.0.0/0

● 9001: Allows external access to the
application management page.

● 3306: Allows access to MySQL
databases.
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Resource Configuration Description

Domain name wpwebsite.com ● If the website is only used for
personal development or testing,
there is no need to add a domain
name.

● If the website is open to the public,
add and resolve a domain name
for the cloud server.

 

Process

Step Procedure Description

1 Purchasing
and
Configuring a
FlexusL
Instance

Purchase and configure a FlexusL instance, including
configuring a security group and adding and resolving
a domain name.

2 Initializing
WordPress

Log in to the dashboard, set the username and
password, and install WordPress. The image
application dashboard needs to be initialized only
when you log in for the first time.

3 Setting up
WordPress

On the dashboard, perform the following operations:
● Set themes
● Install plugins
● Configure SMTP
● Configure a domain name
● Reset a password

 

4.2 Purchasing and Configuring a FlexusL Instance
This section describes how to purchase and configure a FlexusL instance, including
purchasing a cloud server, setting the server login password, logging in to the
server, configuring a security group, and adding and resolving a domain name.

Process

Procedure Description

Step 1: Purchase a
FlexusL Instance

Purchase a FlexusL instance and select the WordPress
application image.

Step 2: Configure a
Security Group

Add inbound security group rules to ensure that the
application preinstalled in the image can be accessed.
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Procedure Description

(Optional) Step 3:
Add and Resolve a
Domain Name

Add and resolve a domain name for the server so that
users can use the domain name to access the website.
If the website is only used for personal development or
testing, there is no need to add a domain name.

(Optional) Step 4:
Apply for and Install
an SSL Certificate for
Your Instance

Install an SSL certificate if you need to enable HTTPS
on your server.

 

Step 1: Purchase a FlexusL Instance
1. Log in to the FlexusL console.
2. Click Buy FlexusL.
3. Specify required parameters for the FlexusL instance.

Paramet
er

Example Description

Region CN-Hong
Kong

For low network latency and quick resource access,
select the region nearest to your target users. After
a FlexusL instance is created, the region cannot be
changed. Exercise caution when selecting a region.
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Paramet
er

Example Description

Applicati
on
Images

WordPres
s

Select the WordPress application image.

Instance
Specificat
ions

2 vCPUs |
2 GiB
memory
and 60
GiB
system
disk

Select instance specifications as needed.

Instance
Name

Wordpres
s-
Example

Customize an instance name that is easy to
identify, for example, Wordpress-Example.

(Optional
)
Associate
d Services

● Data
disk:
10 GiB

● Host
securit
y

● Cloud
backu
p
vault:
70 GiB

You can bundle any of the services to your FlexusL
instances as needed: EVS, HSS (basic edition), and
CBR and set specifications as needed.

Required
Duration

1 month The minimum duration of a purchase is one month
and the maximum duration is three years.
Auto-renew is enabled by default, which means the
purchased FlexusL instances will be automatically
renewed before they expire. If you do not enable
auto-renew during the purchase process, you can
still enable it later after the instances are created.
Monthly subscription allows you to renew the
subscription for one month every time. The number
of renewal times is not limited.
For more information about auto-renewal rules, see
Auto-Renewal Rules.

Quantity 1 Set the number of FlexusL instances to be
purchased.

 
4. Click Buy Now.

On the displayed page, confirm the order details, read and select the
agreement, and click Submit.

5. Select a payment method and complete the payment.
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6. Go back to the FlexusL console and view the purchased FlexusL instance.

Step 2: Configure a Security Group
Add inbound security group rules to ensure that the application preinstalled in the
image can be accessed.

1. Log in to the console and click a resource card to go to the instance details
page.

2. In the navigation pane on the left, choose Cloud Servers and then click the
server name.

3. On the Security Groups tab, click Add Rule. In the displayed dialog box, add
rules displayed in the following figure and click OK.
The following figure only displays common rules. You can add more rules as
needed.

Table 4-1 Security group rules

Priori
ty

Acti
on

Type Protoco
l & Port

Source Description

100 Allo
w

IPv4 TCP:
3306

0.0.0.0/0 Allows access to MySQL
databases

100 Allo
w

IPv4 TCP: 80 0.0.0.0/0 Allows access to the HECS L
instance via HTTP

100 Allo
w

IPv4 TCP:
443

0.0.0.0/0 Allows access to the HECS L
instance via HTTPS

100 Allo
w

IPv4 TCP:
9001

0.0.0.0/0 Allows external access to the
application management
page
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(Optional) Step 3: Add and Resolve a Domain Name
Add and resolve a domain name for the server so that users can use the domain
name to access the website. If the website is only used for personal development
or testing, there is no need to add a domain name.

1. In the navigation pane on the left, choose Cloud Servers. Locate the server
and click its name.

2. On the Server Details page, click the Domain Names tab and click Add
Domain Name.

Parameter Setting

Domain Name Enter a domain name that will be added for the instance,
for example, wpwebsite.com.
NOTE

A domain name that is not registered can be added. After the
domain name is added, it must be registered and licensed. To
ensure that a domain name can be used normally, register the
domain name and complete ICP licensing before adding the
domain name.

Enterprise
Project

Select an enterprise project from the drop-down list.
Enterprise projects are associated with public zones. You
can manage public zones by enterprise project.
NOTE

This parameter is displayed only when your account is an
enterprise account.

 
3. Click OK.
4. In the row containing the wpwebsite.com domain name, click Configure

Record Set.
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Parameter Setting

Domain
Name Prefix

If you enter a prefix, a subdomain is used for website access.
Either the domain name or its subdomains can be resolved
to the EIP of the instance.
Suppose the domain name is wpwebsite.com.
● If the domain name prefix is left empty, wpwebsite.com is

resolved to the EIP.
● If the domain name prefix is www, the subdomain

www.wpwebsite.com is mapped to the EIP.

EIP The EIP bound to the instance is displayed here
automatically.

 
5. On the Domain Names tab, view the domain name resolution details.
6. Apply for ICP licensing for the domain name.

To successfully access the server using a domain name, you must file the
domain name. Domain name filing in the Huawei Cloud ICP license center is
free of charge. For details, see ICP Filing Process.

(Optional) Step 4: Apply for and Install an SSL Certificate for Your Instance
Install an SSL certificate if you need to enable HTTPS on your server. For details,
see About SCM and SSL Certificate Usage.

4.3 Initializing WordPress
The image application dashboard needs to be initialized only when you log in for
the first time.

1. On the Overview page, click Access in the Dashboard field in the Image
area.
After WordPress is initialized, click Access in the Website Homepage field.

2. Select the WordPress language and continue.
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3. Set the website title, WordPress administrator username, password, and email,
and click Install WordPress.
Keep your website administrator username, password, and email secure. If
you forgot the password, you can use this email to reset the password.
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4. Enter the administrator username and password and click Log In.

Then, you have obtained a WordPress hosting server. You can set up a website or
follow the instructions provided in Setting up WordPress to set up WordPress.
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4.4 Setting up WordPress

Managing Appearance

WordPress provides a wide range of themes. You can select an appropriate one for
your WordPress website. You can change the WordPress theme of your website
without changing the website content and structure.

1. Choose Appearance > Themes on the WordPress dashboard.
You can use the default and active themes, or add new themes.
– Select a theme from the theme collection provided by WordPress.
– Click Add New and upload third-party themes.

2. After installing a theme, click Activate.
3. Choose Page > Add New and use the fusion builder provided by the theme to

flexibly set up a web page.

Managing Plugins

WordPress provides many plugins that add more capabilities, choices, and options
to your WordPress website.
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● Choose Plugins > Installed Plugins.

You can view all the plugins that have been installed and their details, such as
the developer and functions.

● Choose Plugins > Add New and add plugins.

– In the upper right corner, select a filter and search for plugins from the
WordPress plugin library.

– Click Upload Plugin and select a third-party plugin for installation.

Configuring SMTP

The following uses the 163 email as an example to show how to use the WP Mail
SMTP plugin to configure SMTP.

1. Choose Settings > General and set the administration email address.
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2. Install the WP Mail SMTP plugin.

a. On the WordPress dashboard, choose Plugins > Add New.
b. Search for the keyword WP Mail SMTP. In the displayed result, click

Install Now. After the installation is complete, click Activate.

3. Go back to the dashboard, configure SMTP, and click Save Settings.
The following uses the 163 mailbox as an example to show how to configure
a mailbox. If you use another mailbox, specify corresponding parameters.

Parameter Description

From Email The email address that emails are sent from, which is the
email address that you specify during WordPress
installation by default. In this example, the value is
example@163.com. You can change the value as needed.
NOTE

SMTP must be configured for the email address.

From Name The name that emails are sent from, which can be your
website name. The default value is the website title that
you specify during WordPress installation. In this example,
the value is WordPress-example. You can change the value
as needed.

Mailer Select Other SMTP.

SMTP Host SMTP host IP address. Enter smtp.163.com in this example.

Encryption Select SSL.

SMTP Port Enter 465 in this example.

Auto TLS Enable this function.

Authenticatio
n

Enable this function.

SMTP
Username

Keep it the same as the From Email parameter value:
example@163.com.
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Parameter Description

SMTP
Password

Enter the authorization code obtained when configuring
SMTP for the email example@163.com. This is not the
password of the email example@163.com.

 

Configuring a WordPress Domain Name
If you add a domain name to a cloud server, or remove a domain name from a
cloud server and then add a new one to it, you need to configure the domain
name in WordPress so that the new domain name can be used to access the
WordPress website.

On the WordPress dashboard, choose Settings > General, set WordPress Address
(URL) and Site Address (URL) to the new domain name, and click Save Changes.

Resetting a Password
If you forgot the WordPress administrator password, you can reset the password
via email (SMTP must have been configured for WordPress).

● Resetting a password via email

a. On the WordPress login page, click Lost your password.
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b. Enter the username or email address and click Get New Password.

Then a new password will be sent to your email.

c. On the dashboard, choose Users > Profile. In the Account Management
area on the displayed page, set a new password and click Update Profile.
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5 Managing Servers Using the BT Panel

5.1 Overview

Applicable Scenario
The BT panel is a visualized server management software that supports more than
100 server management functions, such as one-click LAMP, LNMP, monitoring,
website, FTP, database, and Java. The BT panel application image uses Ubuntu
22.04 and provides a web client for you to manage servers, such as website or file
management, graphical monitoring, and task planning. You can use this
application image to manage servers on the BT panel.

Resource Planning and Costs
Resource Configuration Description

Cloud server ● vCPUs: 2
● Memory: 2 GiB

A BT panel application image requires
at least 2 vCPUs and 2 GiB memory.
Select appropriate instance
specifications accordingly.

Image BT panel Select the BT panel application image.

Security group Inbound rule:
● Protocol/

Application: TCP
● Port:

80,443,8888,909
0,3306

● Source: 0.0.0.0/0

● 80: Allows HTTP traffic to FlexusL
instances.

● 443: Allows HTTPS traffic to FlexusL
instances.

● 8888: Allows access to the BT panel.
● 3306: Allows access to MySQL

databases
● 9090: Allows access to the

phpMyAdmin database
management tool
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Resource Configuration Description

Domain name wpwebsite.com ● If the website is only used for
personal development or testing,
there is no need to add a domain
name.

● If the website is open to the public,
add and resolve a domain name for
the cloud server.

 

Process
Step Procedure Description

1 Purchasing
and
Configuring a
FlexusL
Instance

Purchase and configure a FlexusL instance.

2 Initializing the
BT Panel

Log in to the BT dashboard and install the basic
software bundle.

3 Deploying the
BT Panel

On the dashboard, perform the following operations:
● Manage software
● Manage files
● Manage logs
● Manage databases

 

5.2 Purchasing and Configuring a FlexusL Instance
This section describes how to purchase and configure a FlexusL instance, including
purchasing a cloud server, setting the server login password, and configuring a
security group.

Process
Procedure Description

Step 1: Purchase a
FlexusL Instance

Purchase a FlexusL instance and select the BT panel
application image.

Step 2: Configure a
Security Group

Add inbound security group rules to ensure that the
application preinstalled in the image can be accessed.

Huawei Cloud Flexus
Best Practices 5 Managing Servers Using the BT Panel

Issue 02 (2024-06-04) Copyright © Huawei Cloud Computing Technologies Co., Ltd. 42



Procedure Description

(Optional) Step 3:
Add and Resolve a
Domain Name

Add and resolve a domain name for the server so that
users can use the domain name to access the website. If
the website is only used for personal development or
testing, there is no need to add a domain name.

 

Step 1: Purchase a FlexusL Instance
1. Log in to the FlexusL console.
2. Click Buy FlexusL.
3. Specify required parameters for the FlexusL instance.

Para
meter

Example Description

Regio
n

CN-Hong
Kong

For low network latency and quick resource access,
select the region nearest to your target users. After a
FlexusL instance is created, the region cannot be
changed. Exercise caution when selecting a region.
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Para
meter

Example Description

Applic
ation
Image
s

BT panel Select the BT panel application image.

Instan
ce
Specifi
cation
s

2 vCPUs |
2 GiB
memory
and 60
GiB
system
disk

Select instance specifications as needed.

Instan
ce
Name

BT-
example

Customize an instance name that is easy to identify,
for example, BT-example.

(Optio
nal)
Associ
ated
Servic
es

● Data
disk:
10 GiB

● Host
securit
y

● Cloud
backu
p
vault:
70 GiB

You can bundle any of the services to your FlexusL
instances as needed: EVS, HSS (basic edition), and CBR
and set specifications as needed.

Requir
ed
Durati
on

1 month The minimum duration of a purchase is one month
and the maximum duration is three years.
Auto-renew is enabled by default, which means the
purchased FlexusL instances will be automatically
renewed before they expire. If you do not enable auto-
renew during the purchase process, you can still
enable it later after the instances are created. Monthly
subscription allows you to renew the subscription for
one month every time. The number of renewal times is
not limited.
For more information about auto-renewal rules, see
Auto-Renewal Rules.

Quant
ity

1 Set the number of FlexusL instances to be purchased.

 
4. Click Buy Now.

On the displayed page, confirm the order details, read and select the
agreement, and click Submit.
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5. Select a payment method and complete the payment.

6. Go back to the FlexusL console and view the purchased FlexusL instance.

Step 2: Configure a Security Group
1. Log in to the console and click a resource card to go to the instance details

page.

2. In the navigation pane on the left, choose Cloud Servers and then click the
server name.

3. On the Security Groups tab, click Add Rule. In the displayed dialog box, add
rules displayed in the following figure and click OK.

The following figure only displays common rules. You can add more rules as
needed.

Table 5-1 Security group rules

Priorit
y

Actio
n

Typ
e

Protocol
& Port

Source Description

100 Allow IPv
4

TCP:
3306

0.0.0.0/0 Allows access to MySQL
databases

100 Allow IPv
4

TCP:
9090

0.0.0.0/0 Allows access to the
phpMyAdmin database
management tool
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Priorit
y

Actio
n

Typ
e

Protocol
& Port

Source Description

100 Allow IPv
4

TCP:
8888

0.0.0.0/0 Allows access to the BT
panel dashboard.

100 Allow IPv
4

TCP: 443 0.0.0.0/0 Allows HTTPS traffic to
FlexusL instances.

100 Allow IPv
4

TCP: 80 0.0.0.0/0 Allows HTTP traffic to
FlexusL instances.

 

(Optional) Step 3: Add and Resolve a Domain Name
Add and resolve a domain name for the server so that users can use the domain
name to access the website. If the website is only used for personal development
or testing, there is no need to add a domain name.

1. In the navigation pane on the left, choose Cloud Servers. Locate the server
and click its name.

2. On the Server Details page, click the Domain Names tab and click Add
Domain Name.

Parameter Setting

Domain Name Enter a domain name that will be added for the instance,
for example, wpwebsite.com.
NOTE

A domain name that is not registered can be added. After the
domain name is added, it must be registered and licensed. To
ensure that a domain name can be used normally, register the
domain name and complete ICP licensing before adding the
domain name.

Enterprise
Project

Select an enterprise project from the drop-down list.
Enterprise projects are associated with public zones. You
can manage public zones by enterprise project.
NOTE

This parameter is displayed only when your account is an
enterprise account.

 
3. Click OK.
4. In the row containing the wpwebsite.com domain name, click Configure

Record Set.
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Parameter Setting

Domain
Name Prefix

If you enter a prefix, a subdomain is used for website access.
Either the domain name or its subdomains can be resolved
to the EIP of the instance.
Suppose the domain name is wpwebsite.com.
● If the domain name prefix is left empty, wpwebsite.com is

resolved to the EIP.
● If the domain name prefix is www, the subdomain

www.wpwebsite.com is mapped to the EIP.

EIP The EIP bound to the instance is displayed here
automatically.

 
5. On the Domain Names tab, view the domain name resolution details.
6. Apply for ICP licensing for the domain name.

To successfully access the server using a domain name, you must file the
domain name. Domain name filing in the Huawei Cloud ICP license center is
free of charge. For details, see ICP Filing Process.

5.3 Initializing the BT Panel
The image application dashboard needs to be initialized only when you log in for
the first time.

1. Obtain the administrator username and password for logging in to the BT
panel.
Log in to the server and run sudo cat /credentials/password.txt to obtain
the username and password for logging in to the BT panel. The administrator
username is administrator.

2. On the Overview page, click Access in the Dashboard field in the Image
area.
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3. Enter the obtained username and password and click Login.

4. Install the basic software bundle.
Select LNMP (recommended) or LAMP and click One-click to install them.
You can also select other software from App Store and install them.

Then, you have obtained a BT panel hosting server. You can use the BT panel or
follow the instructions provided in Deploying the BT Panel to manage software,
files, logs, and databases.
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5.4 Deploying the BT Panel

Specifying a Domain Name
If you want to use a domain name to access the BT panel, configure one for the
BT panel first. Once a domain name is specified, you can only use it to access the
BT panel.

If your FlexusL instance does not need a domain name, skip this part.

Managing Software
In the software store, you can install, uninstall, and manage software.

You can search for the software by name or category. A PHP extension plugin is
required to enhance PHP language functions. The following shows how to install a
PHP extension:

1. Choose App Store in the left navigation pane and search for PHP.
2. Select the PHP version, click Install or Buy now in the Operation column of

the target software and complete the installation.

Managing Files
In the Files menu, you can perform a range of operations on files, including
copying, pasting, cutting, deleting, renaming, compressing, refreshing, or creating
a file, and creating a directory for a file.
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Managing Logs
In the Logs menu, logs are classified by log type. You can click the tabs to view
different types of logs and clear logs.
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6 Analyzing Website Data Using the
Matomo Application Image

6.1 Overview

Applicable Scenario
Matomo is a powerful open-source network analysis platform that has full data
ownership and ensures that the business complies with General Data Protection
Regulation (GDPR) and California Consumer Privacy Act (CCPA). The Matomo
application image uses Ubuntu 22.04 and is deployed using Docker. The Nginx,
MySQL, phpMyAdmin, and Docker have been preconfigured in the image. You can
use this application image to analyze website data with Matomo.

Resource Planning and Costs
Resource Configuration Description

Cloud server ● vCPUs: 2
● Memory: 2 GiB

Select appropriate instance
specifications based on your service
requirements.

Image Matomo Select the Matomo application image.

Security group Inbound rule:
● Protocol/

Application: TCP
● Port: 9001
● Source IP:

0.0.0.0/0

9001: Allows external access to the
application management page.
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Resource Configuration Description

Domain name wpwebsite.com ● If the website is only used for
personal development or testing,
there is no need to add a domain
name.

● If the website is open to the public,
add and resolve a domain name for
the cloud server.

 

Process

Step Procedure Description

1 Purchasing
and
Configuring a
FlexusL
Instance

Purchase and configure a FlexusL instance.

2 Initializing
Matomo

Install and initialize Matomo.

3 Using
Matomo to
Monitor
Websites

Add tracking code to the websites you want to
monitor.

 

6.2 Purchasing and Configuring a FlexusL Instance
This section describes how to purchase and configure a FlexusL instance, including
purchasing a cloud server, setting the server login password, logging in to the
server, configuring a security group, and adding and resolving a domain name.

Process

Procedure Description

Step 1: Purchase a
FlexusL Instance

Purchase a FlexusL instance and select the Matomo
application image.

Step 2: Configure a
Security Group

Add inbound security group rules to ensure that the
application preinstalled in the image can be accessed.

(Optional) Step 3:
Add and Resolve a
Domain Name

Add and resolve a domain name for the server so that
users can use the domain name to access the website. If
the website is only used for personal development or
testing, there is no need to add a domain name.

 

Huawei Cloud Flexus
Best Practices

6 Analyzing Website Data Using the Matomo
Application Image

Issue 02 (2024-06-04) Copyright © Huawei Cloud Computing Technologies Co., Ltd. 52



Step 1: Purchase a FlexusL Instance
1. Log in to the FlexusL console.
2. Click Buy FlexusL.
3. Specify required parameters for the FlexusL instance.

Paramet
er

Example Description

Region CN-Hong
Kong

For low network latency and quick resource access,
select the region nearest to your target users. After
a FlexusL instance is created, the region cannot be
changed. Exercise caution when selecting a region.

Applicati
on
Images

Matomo Select the Matomo application image.

Instance
Specificat
ions

2 vCPUs |
2 GiB
memory
and 60
GiB
system
disk

Select instance specifications as needed.
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Paramet
er

Example Description

(Optional
) Instance
Name

Matomo
-Example

Customize an instance name that is easy to identify,
for example, Matomo-Example.

(Optional
)
Associate
d Services

● Data
disk:
10
GiB

● Host
securi
ty

● Cloud
backu
p
vault:
70
GiB

You can bundle any of the services to your FlexusL
instances as needed: EVS, HSS (basic edition), and
CBR and set specifications as needed.

Required
Duration

1 month The minimum duration of a purchase is one month
and the maximum duration is three years.
Auto-renew is enabled by default, which means the
purchased FlexusL instances will be automatically
renewed before they expire. If you do not enable
auto-renew during the purchase process, you can
still enable it later after the instances are created.
Monthly subscription allows you to renew the
subscription for one month every time. The number
of renewal times is not limited.
For more information about auto-renewal rules, see
Auto-Renewal Rules.

Quantity 1 Set the number of FlexusL instances to be
purchased.

 

4. Click Buy Now.

On the displayed page, confirm the order details, read and select the
agreement, and click Submit.

5. Select a payment method and complete the payment.

6. Go back to the FlexusL console and view the purchased FlexusL instance.

Step 2: Configure a Security Group

Add inbound security group rules to ensure that the application preinstalled in the
image can be accessed.

1. Log in to the console and click a resource card to go to the instance details
page.
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2. In the navigation pane on the left, choose Cloud Servers and then click the
server name.

3. On the Security Groups tab, click Add Rule. In the displayed dialog box, add
rules displayed in the following figure and click OK.
The following figure only displays common rules. You can add more rules as
needed.

Table 6-1 Security group rules

Priorit
y

Actio
n

Type Protocol
& Port

Source Description

100 Allow IPv4 TCP:
9001

0.0.0.0/0 Allows external access to
the application
management page.

 

(Optional) Step 3: Add and Resolve a Domain Name
Add and resolve a domain name for the server so that users can use the domain
name to access the website. If the website is only used for personal development
or testing, there is no need to add a domain name.

1. In the navigation pane on the left, choose Cloud Servers. Locate the server
and click its name.

2. On the Server Details page, click the Domain Names tab and click Add
Domain Name.

Parameter Setting

Domain Name Enter a domain name that will be added for the instance,
for example, wpwebsite.com.
NOTE

A domain name that is not registered can be added. After the
domain name is added, it must be registered and licensed. To
ensure that a domain name can be used normally, register the
domain name and complete ICP licensing before adding the
domain name.
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Parameter Setting

Enterprise
Project

Select an enterprise project from the drop-down list.
Enterprise projects are associated with public zones. You
can manage public zones by enterprise project.
NOTE

This parameter is displayed only when your account is an
enterprise account.

 

3. Click OK.

4. In the row containing the wpwebsite.com domain name, click Configure
Record Set.

Parameter Setting

Domain
Name Prefix

If you enter a prefix, a subdomain is used for website access.
Either the domain name or its subdomains can be resolved
to the EIP of the instance.
Suppose the domain name is wpwebsite.com.
● If the domain name prefix is left empty, wpwebsite.com is

resolved to the EIP.
● If the domain name prefix is www, the subdomain

www.wpwebsite.com is mapped to the EIP.

EIP The EIP bound to the instance is displayed here
automatically.

 

5. On the Domain Names tab, view the domain name resolution details.

6. Apply for ICP licensing for the domain name.

To successfully access the server using a domain name, you must file the
domain name. Domain name filing in the Huawei Cloud ICP license center is
free of charge. For details, see ICP Filing Process.

6.3 Initializing Matomo
The image application dashboard needs to be initialized only when you log in for
the first time.
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1. On the Overview page, click Access in the Dashboard field in the Image
area.

2. Click NEXT.

3. Wait until Matomo completes the system check and click NEXT.
Matomo automatically checks whether the server meets the requirements for
installing Matomo and displays the check result for each item.

4. Set up the MySQL database and click NEXT.
The MySQL database and a default database account have been preset in
Matomo. The information about the default database account is
automatically obtained. Retain the default settings and click NEXT.

5. After Matomo automatically creates data tables, click NEXT.
6. On the Super User page, set the username, password, and email address of

the Matomo administrator, and click NEXT.
The super user is the user that you created when you installed Matomo. Each
Matomo has only one super user who has the highest permissions. Keep the
username and password of the super user secure.
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7. On the Set up a Website page, add the name and URL of the first website
you want to track and analyze with Matomo and click NEXT.

You can add more websites to track later.

8. Learn about the JavaScript tracking code and click NEXT.

To track your web traffic with Matomo, you need to make sure that some
extra code is added to each of your webpages. Matomo automatically
generates a JavaScript tracking code. Make sure that this code is on every
page that you want Matomo to analyze.

After the installation is complete, you can generate customized tracking code
in the Tracking Code admin section.

9. After the initialization configurations are complete, click Continue to
Matomo.
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10. Enter the username and password of the super user and click SIGN IN.

Then, you have obtained a Matomo hosting server. You can start using Matomo or
follow the instructions provided in Using Matomo to Monitor Websites to
monitor websites.

6.4 Using Matomo to Monitor Websites
1. On the dashboard, click the TRACKING CODE tab and copy the tracking code

in the Tracking Code area.
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2. Copy the tracking code to each page of the website you want to monitor.
Matomo can collect real-time analysis data of the website with the tracking
code.

NO TE

For details about how to install the Matomo tracking code, see official
documentation.

3. Select All Websites to view the access to the monitored websites.
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7 Visualizing Docker Management Using
Portainer

7.1 Overview

Applicable Scenario
Portainer is a graphical tool for Docker management. It offers a range of functions
such as status display, quick deployment of application templates, basic operations
on Docker (containers, images, networks, and database logical volumes), log
display, container console operations, centralized management and operations of
Swarm clusters and services, and user login management and control. The
Portainer application image uses Ubuntu 22.04 and is deployed using Docker. The
Docker and Portainer have been preconfigured in the image. You can use this
application image to visualize Docker management.

Resource Planning and Costs
Resource Configuration Description

Cloud server ● vCPUs: 2
● Memory: 4 GiB

Select appropriate instance
specifications based on your service
requirements.

Image Portainer Select the Portainer application image.

Security group Inbound rule:
● Protocol/

Application: TCP
● Port: 9001,3306
● Source IP:

0.0.0.0/0

● 9001: Allows external access to the
application management page.

● 3306: Allows access to MySQL
databases
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Resource Configuration Description

Domain name wpwebsite.com ● If the website is only used for
personal development or testing,
there is no need to add a domain
name.

● If the website is open to the public,
add and resolve a domain name for
the cloud server.

 

Process

Step Procedure Description

1 Purchasing and
Configuring a
FlexusL
Instance

Purchase and configure a FlexusL instance.

2 Initializing
Portainer

Log in to the dashboard and install and initialize
Portainer.

3 Using Portainer
to Deploy a
MySQL
Container

Use Portainer to visualize Docker management
(using MySQL container as an example)

 

7.2 Purchasing and Configuring a FlexusL Instance
This section describes how to purchase and configure a FlexusL instance, including
purchasing a cloud server, setting the server login password, logging in to the
server, configuring a security group, and adding and resolving a domain name.

Process

Procedure Description

Step 1: Purchase a
FlexusL Instance

Purchase a FlexusL instance and select the Portainer
application image.

Step 2: Configure a
Security Group

Add inbound security group rules to ensure that the
application preinstalled in the image can be accessed.

(Optional) Step 3:
Add and Resolve a
Domain Name

Add and resolve a domain name for the server so that
users can use the domain name to access the website. If
the website is only used for personal development or
testing, there is no need to add a domain name.
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Step 1: Purchase a FlexusL Instance
1. Log in to the FlexusL console.
2. Click Buy FlexusL.
3. Specify required parameters for the FlexusL instance.

Paramet
er

Example Description

Region CN-Hong
Kong

For low network latency and quick resource access,
select the region nearest to your target users. After
a FlexusL instance is created, the region cannot be
changed. Exercise caution when selecting a region.

Applicati
on
Images

Portainer Select the Portainer application image.

Instance
Specificat
ions

2 vCPUs |
4 GiB
memory
and 80
GiB
system
disk

Select instance specifications as needed.

Instance
Name

Portainer
-Example

Customize an instance name that is easy to identify,
for example, Portainer-Example.
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Paramet
er

Example Description

(Optional
)
Associate
d Services

● Data
disk:
10 GiB

● Host
securit
y

● Cloud
backu
p
vault:
90 GiB

You can bundle any of the services to your FlexusL
instances as needed: EVS, HSS (basic edition), and
CBR and set specifications as needed.

Required
Duration

1 month The minimum duration of a purchase is one month
and the maximum duration is three years.
Auto-renew is enabled by default, which means the
purchased FlexusL instances will be automatically
renewed before they expire. If you do not enable
auto-renew during the purchase process, you can
still enable it later after the instances are created.
Monthly subscription allows you to renew the
subscription for one month every time. The number
of renewal times is not limited.
For more information about auto-renewal rules, see
Auto-Renewal Rules.

Quantity 1 Set the number of FlexusL instances to be
purchased.

 
4. Click Buy Now.

On the displayed page, confirm the order details, read and select the
agreement, and click Submit.

5. Select a payment method and complete the payment.
6. Go back to the FlexusL console and view the purchased FlexusL instance.

Step 2: Configure a Security Group
Add inbound security group rules to ensure that the application preinstalled in the
image can be accessed.

1. Log in to the console and click a resource card to go to the instance details
page.

2. In the navigation pane on the left, choose Cloud Servers and then click the
server name.
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3. On the Security Groups tab, click Add Rule. In the displayed dialog box, add
rules displayed in the following figure and click OK.
The following figure only displays common rules. You can add more rules as
needed.

Table 7-1 Security group rules

Prior
ity

Acti
on

Type Protocol
& Port

Source Description

100 Allo
w

IPv4 TCP: 3306 0.0.0.0/0 Allows access to MySQL
databases.

100 Allo
w

IPv4 TCP: 9001 0.0.0.0/0 Allows external access to
the application
management page.

 

(Optional) Step 3: Add and Resolve a Domain Name
Add and resolve a domain name for the server so that users can use the domain
name to access the website. If the website is only used for personal development
or testing, there is no need to add a domain name.

1. In the navigation pane on the left, choose Cloud Servers. Locate the server
and click its name.

2. On the Server Details page, click the Domain Names tab and click Add
Domain Name.

Parameter Setting

Domain Name Enter a domain name that will be added for the instance,
for example, wpwebsite.com.
NOTE

A domain name that is not registered can be added. After the
domain name is added, it must be registered and licensed. To
ensure that a domain name can be used normally, register the
domain name and complete ICP licensing before adding the
domain name.
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Parameter Setting

Enterprise
Project

Select an enterprise project from the drop-down list.
Enterprise projects are associated with public zones. You
can manage public zones by enterprise project.
NOTE

This parameter is displayed only when your account is an
enterprise account.

 

3. Click OK.

4. In the row containing the wpwebsite.com domain name, click Configure
Record Set.

Parameter Setting

Domain
Name Prefix

If you enter a prefix, a subdomain is used for website access.
Either the domain name or its subdomains can be resolved
to the EIP of the instance.
Suppose the domain name is wpwebsite.com.
● If the domain name prefix is left empty, wpwebsite.com is

resolved to the EIP.
● If the domain name prefix is www, the subdomain

www.wpwebsite.com is mapped to the EIP.

EIP The EIP bound to the instance is displayed here
automatically.

 

5. On the Domain Names tab, view the domain name resolution details.

6. Apply for ICP licensing for the domain name.

To successfully access the server using a domain name, you must file the
domain name. Domain name filing in the Huawei Cloud ICP license center is
free of charge. For details, see ICP Filing Process.

7.3 Initializing Portainer
The image application dashboard needs to be initialized only when you log in for
the first time.
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1. On the Overview page, click Access in the Dashboard field in the Image
area.

Portainer initialization has a certain validity period. If no users are created
within the validity period, the following message is displayed. In this case, log
in to the server and run sudo docker restart portainer to restart Portainer,
and then create a user as soon as possible.

2. Set the username and password of the Portainer administrator and click
Create user.
If you have backup data for Portainer, click Restore Portainer from backup
and upload the backup data to quickly set up the Portainer environment.

3. Choose Home and click local to use Portainer for Docker visual management.
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Then, you have obtained a Portainer hosting server. You can start using Portainer
or follow the instructions provided in Using Portainer to Deploy a MySQL
Container to create and connect to a MySQL container.

7.4 Using Portainer to Deploy a MySQL Container
This section uses the MySQL container as an example to describe how to use
Portainer to visualize Docker management.

Creating a MySQL Container
1. Choose Containers in the left navigation pane and click Add container.

2. Specify MySQL container parameters.
– ① Name: user-defined container name.
– ② Image: container image name. For example, if you set this parameter

to mysql:5.7, the system automatically pulls the MySQL5.7 container
image from Docker Hub.

– ③ Click publish a new network port and add port 3306 to ensure that
the MySQL database can be accessed.

– ④ Env: environment variables.

▪ MYSQL_ROOT_PASSWORD: password of the root user of the
database. This parameter is mandatory. It is used for logging in to
the MySQL container. Keep the password secure.

NO TE

Ensure that the MYSQL_ROOT_PASSWORD parameter name is correctly
entered, or the database cannot be connected.
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▪ MYSQL_DATABASE: name (such as wordpress) of the database
which is automatically created in the value row after the MySQL
container is created. This parameter is optional.

– ⑤ Restart policy: You are advised to select Always so that the container
is always automatically restarted when it is stopped.

3. Click Deploy the container to create a MySQL container.

Connecting to the MySQL Container
1. Return to the container list and click  in the MySQL container row.

2. On the displayed page, click Connect to connect to the container.
3. Run the following command to log in to the MySQL database:

mysql -uroot –p123456, in which 123456 is the value of
MYSQL_ROOT_PASSWORD.
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8 Using GitLab to Manage Teams and
Projects

8.1 Overview

Applicable Scenario
GitLab is a DevOps platform that provides a complete solution for software
development and operations, aiming to help teams collaborate on project
development. On GitLab, you can protect your applications, and manage, plan,
create, validate, package, release, configure, and monitor project source code. The
GitLab image uses Ubuntu 22.04 and is deployed using Docker. The Nginx and
Docker have been preconfigured in the image. This section describes how to use
GitLab to manage teams and projects.

Resource Planning and Costs
The following resource planning is only for your reference. You can adjust it as
required.

Resource Configuration Description

Cloud server vCPUs: 2
Memory: 8 GiB

Select appropriate instance
specifications based on your service
requirements.

Image GitLab Select the GitLab application image.

Security group Inbound rule:
● Protocol/

Application: TCP
● Port: 9001,9000
● Source: 0.0.0.0/0

● 9001: Allows external access to the
application management page.

● 9000: Allows external access to the
dashboard of the application
preinstalled in the image.
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Resource Configuration Description

Domain name wpwebsite.com ● If the website is only used for
personal development or testing,
there is no need to add a domain
name.

● If the website is open to the public,
add and resolve a domain name
for the cloud server.

 

Process
Step Procedure Description

1 Purchasing and
Configuring a
FlexusL
Instance

Purchase and configure a FlexusL instance.

2 Initializing
GitLab

Log in to GitLab and select the desired language for
the Admin Area.

3 Using GitLab Create a project, add project members, and integrate
codes.

 

8.2 Purchasing and Configuring a FlexusL Instance
This section describes how to purchase and configure a FlexusL instance, including
purchasing a cloud server, setting the server login password, logging in to the
server, configuring a security group, and adding and resolving a domain name.

Procedure
Procedure Description

Step 1: Purchase a
FlexusL Instance

Purchase a FlexusL instance and select the GitLab
application image.

Step 2: Configure a
Security Group

Add inbound security group rules to ensure that the
application preinstalled in the image can be accessed.

(Optional) Step 3:
Add and Resolve a
Domain Name

Add and resolve a domain name for the server so that
users can use the domain name to access the website. If
the website is only used for personal development or
testing, there is no need to add a domain name.
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Step 1: Purchase a FlexusL Instance
1. Log in to the FlexusL console.
2. Click Buy FlexusL.
3. Specify required parameters for the FlexusL instance.

Paramet
er

Example Description

Region CN-Hong
Kong

For low network latency and quick resource
access, select the region nearest to your target
users. After a FlexusL instance is created, the
region cannot be changed. Exercise caution
when selecting a region.

Applicati
on
Images

GitLab Select the GitLab application image.

Instance
Specificat
ions

2 vCPUs | 8
GiB memory

Select instance specifications as needed.

Instance
Name

GitLab-
Example

Customize an instance name that is easy to
identify, for example, GitLab-Example.
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Paramet
er

Example Description

(Optional
)
Associate
d Services

● Data disk:
10 GiB

● Host
security

● Cloud
backup
vault: 170
GiB

You can bundle any of the services to your
FlexusL instances as needed: EVS, HSS (basic
edition), and CBR and set specifications as
needed.

Required
Duration

1 month The minimum duration of a purchase is one
month and the maximum duration is three
years.
Auto-renew is enabled by default, which means
the purchased FlexusL instances will be
automatically renewed before they expire. If
you do not enable auto-renew during the
purchase process, you can still enable it later
after the instances are created. Monthly
subscription allows you to renew the
subscription for one month every time. The
number of renewal times is not limited.
For more information about auto-renewal rules,
see Auto-Renewal Rules.

Quantity 1 Set the number of FlexusL instances to be
purchased.

 
4. Click Buy Now.

On the displayed page, confirm the order details, read and select the
agreement, and click Submit.

5. Select a payment method and complete the payment.
6. Go back to the FlexusL console and view the purchased FlexusL instance.

Step 2: Configure a Security Group
Add inbound security group rules to ensure that the application preinstalled in the
image can be accessed.

1. Log in to the console and click a resource card to go to the instance details
page.

2. In the navigation pane on the left, choose Cloud Servers and then click the
server name.
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3. On the Security Groups tab, click Add Rule. In the displayed dialog box, add
rules displayed in the following figure and click OK.
The following figure only displays common rules. You can add more rules as
needed.

Table 8-1 Security group rules

Priorit
y

Actio
n

Type Protocol
& Port

Source Description

100 Allow IPv4 TCP:
9001

0.0.0.0/0 Allows external access to
the application
management page.

100 Allow IPv4 TCP:
9000

0.0.0.0/0 Allows external access to
the application O&M
dashboard.

 

(Optional) Step 3: Add and Resolve a Domain Name
Add and resolve a domain name for the server so that users can use the domain
name to access the website. If the website is only used for personal development
or testing, there is no need to add a domain name.

1. In the navigation pane on the left, choose Cloud Servers. Locate the server
and click its name.

2. On the Server Details page, click the Domain Names tab and click Add
Domain Name.
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Parameter Setting

Domain Name Enter a domain name that will be added for the instance,
for example, wpwebsite.com.
NOTE

A domain name that is not registered can be added. After the
domain name is added, it must be registered and licensed. To
ensure that a domain name can be used normally, register the
domain name and complete ICP licensing before adding the
domain name.

Enterprise
Project

Select an enterprise project from the drop-down list.
Enterprise projects are associated with public zones. You
can manage public zones by enterprise project.
NOTE

This parameter is displayed only when your account is an
enterprise account.

 
3. Click OK.
4. In the row containing the wpwebsite.com domain name, click Configure

Record Set.

Parameter Setting

Domain
Name Prefix

If you enter a prefix, a subdomain is used for website access.
Either the domain name or its subdomains can be resolved
to the EIP of the instance.
Suppose the domain name is wpwebsite.com.
● If the domain name prefix is left empty, wpwebsite.com is

resolved to the EIP.
● If the domain name prefix is www, the subdomain

www.wpwebsite.com is mapped to the EIP.

EIP The EIP bound to the instance is displayed here
automatically.

 
5. On the Domain Names tab, view the domain name resolution details.
6. Apply for ICP licensing for the domain name.
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To successfully access the server using a domain name, you must file the
domain name. Domain name filing in the Huawei Cloud ICP license center is
free of charge. For details, see ICP Filing Process.

8.3 Initializing GitLab
The image application dashboard needs to be initialized only when you log in for
the first time.

1. Obtain the administrator username and password for logging in to GitLab.

a. In the address bar of a local browser, enter http://EIP:9000 to log in to
the application O&M dashboard.
The username and password for logging in to the dashboard are the root
user and password of the FlexusL instance. A FlexusL instance does not
have an initial password. Reset the password and use it to log in to the
dashboard.

b. Choose My Apps and click the App icon.
c. Choose Access and click Initial Account to view the username and

password of the administrator.

2. On the Overview page, click Access in the Dashboard field in the Image
area.

3. Enter the username and password obtained in step 1.
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4. Click Sign in to access the GitLab Admin Area.

After initializing GitLab, you will have a server that uses the GitLab application
image. You can start using GitLab or follow the steps in Using GitLab to create a
project, add project members, and integrate codes.

8.4 Using GitLab
This section describes how to use GitLab to create a project, add project members,
and integrate codes.

Creating a Project

This example demonstrates that how an administrator creates a project, initializes
the project, adds a development branch dev, and hides the master branch main
from developers.
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1. Click  in the upper left corner and choose admin to access the
management center.

2. Choose Projects and click New project.

3. Click Create blank project.
4. Configure parameters for the project and click Create project.

– Project name: Enter a project name that is easy to identify, for example,
Project-example.

– Project URL: It consists of the public IP address of the cloud service and
the administrator account. Select root.

Retain the default values for other parameters.

5. Choose Repository > Files, click  > New file, add the index.html file to
main, and click Commit changes.
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6. Choose Repository > Branches, click New branch, and configure the
development branch dev.
– Branch name: dev
– Create from: main

7. Click Create branch. Then you can view the created development branch dev.

Adding Project Members
After registering an account, users cannot directly log in to GitLab. To let them log
in, the administrator needs to approve their registration, invite them to be
members of the project, and assign permissions to them.

1. Register an account.

a. Visit http://public IP address of the server or http://domain name.
b. Click Register now, enter registration information, and click Register.
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2. The administrator approves the registration.

a. Click  in the upper left corner and select admin.
b. On the Users page, select Pending approval, and click Approve.

3. The administrator invites users to join the project team and assigns
permissions to them.

a. Click  in the upper left corner, choose Projects > View all projects, and
click Administrator/Project-example.

b. Choose Project information > Members and click Invite members.
c. Enter the username or email address, assign Developer permission to

users, and click Invite.
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You can assign users the following five roles: Guest, Reporter,
Developer, Maintainer, or Owner.

▪ Guest: allows users to create issues and post comments, and denies
them to read or write the repository.

▪ Reporter: allows users to clone codes, and denies them to submit
code.

▪ Developer: allows users to clone, develop, submit, and push code.

▪ Master: allows users to create projects, add tags, protect branches,
add new members to the project, and edit projects.

▪ Owner: allows users to assign permissions to access projects, delete
or migrate projects, and manage project team members.

4. Visit http://Public IP address of the server or http://Domain name. Enter the
username and password to log in to GitLab.
When members log in to GitLab for the first time, select a role for better
experience.

Integrating Codes
1. The developers edit and submit code.

a. Visit http://Public IP address of the server or http://Domain name to log
in to GitLab.
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b. Choose Projects and click the target project name.

c. Choose Repository > Branch and click dev.

d. Click Web IED, select a file to edit. For example, edit the index.html file.

e. Choose  on the left navigation pane to go to the SOURCE CONTROL,
and click Commit & Push.

Click No when Commit to a new branch? is displayed.

f. Choose Repository > Files on the project menu bar. You can view Update
file index.html. Click Create merge request
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g. Set request information and click Create merge request.
Specify the Reviewer to Administrator and retain the default values for
other parameters.

2. The administrator reviews the merge request.

a. Click  in the upper right corner, choose Merge requests > New
merge request, and click the specific request title.

b. Click Merge to merge the index.html file from dev into main.
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9 Using PrestaShop to Build an E-
Commerce Website

9.1 Overview

Applicable Scenario
PrestaShop is a full-featured, cross-platform, and open source e-commerce
platform written in the PHP programming language with support for the MySQL
database management system. PrestaShop supports transactions using different
currencies and almost all payment methods, such as Paypal. It is a good choice for
you to build foreign trade websites. The PrestaShop application image uses
Ubuntu 22.04 and is deployed using Docker. The Nginx, MySQL, phpMyAdmin, and
Docker have been preconfigured in the image. This section describes how to use
PrestaShop to build an e-commerce website.

Resource Planning and Costs
This practice uses the following resource planning as an example. You can adjust it
as required.

Resource Configuration Description

Cloud server ● vCPUs: 2
● Memory: 2 GiB

Select appropriate instance
specifications based on your service
requirements.

Image PrestaShop Select the PrestaShop application
image.
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Resource Configuration Description

Security group Inbound rule:
● Protocol/

Application: TCP
● Port:

9001,9000,3306
● Source: 0.0.0.0/0

● 9001: Allows external access to the
application management page.

● 9000: Allows external access to the
dashboard of the application
preinstalled in the image.

● 3306: Allows access to MySQL
databases.

Domain name wpwebsite.com ● If the website is only used for
personal development or testing,
there is no need to add a domain
name.

● If the website is open to the public,
add and resolve a domain name
for the cloud server.

 

Process

Step Procedure Description

1 Purchasing and
Configuring a
FlexusL Instance

Purchase and configure a FlexusL instance.

2 Initializing
PrestaShop

Log in to PrestaShop and select the desired language
for the management page.

3 Deploying
PrestaShop

On the dashboard, perform the following operations:
● Manage language packages and set languages.
● Manage modules
● Back up databases.
● Configure domain names.

 

9.2 Purchasing and Configuring a FlexusL Instance
This section describes how to purchase and configure a FlexusL instance, including
purchasing a cloud server, setting the server login password, logging in to the
server, configuring a security group, and adding and resolving a domain name.

Procedure

Procedure Description

Step 1: Purchase a
FlexusL Instance

Purchase a FlexusL instance and select the PrestaShop
application image.
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Procedure Description

Step 2: Configure a
Security Group

Add inbound security group rules to ensure that the
application preinstalled in the image can be accessed.

(Optional) Step 3:
Add and Resolve a
Domain Name

Add and resolve a domain name for the server so that
users can use the domain name to access the website. If
the website is only used for personal development or
testing, there is no need to add a domain name.

 

Step 1: Purchase a FlexusL Instance
1. Log in to the FlexusL console.
2. Click Buy FlexusL.
3. Specify required parameters for the FlexusL instance.

Paramet
er

Example Description

Region CN-Hong
Kong

For low network latency and quick resource
access, select the region nearest to your target
users. After a FlexusL instance is created, the
region cannot be changed. Exercise caution when
selecting a region.

Applicati
on
Images

PrestaShop Select the PrestaShop application image.
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Paramet
er

Example Description

Instance
Specificat
ions

2 vCPUs | 2
GiB
memory
and 60 GiB
system disk

Select instance specifications as needed.

Instance
Name

PrestaShop
-Example

Customize an instance name that is easy to
identify, for example, PrestaShop-Example.

(Optional
)
Associate
d Services

● Data
disk: 10
GiB

● Host
security

● Cloud
backup
vault:
70 GiB

You can bundle any of the services to your
FlexusL instances as needed: EVS, HSS (basic
edition), and CBR and set specifications as
needed.

Required
Duration

1 month The minimum duration of a purchase is one
month and the maximum duration is three years.
Auto-renew is enabled by default, which means
the purchased FlexusL instances will be
automatically renewed before they expire. If you
do not enable auto-renew during the purchase
process, you can still enable it later after the
instances are created. Monthly subscription allows
you to renew the subscription for one month
every time. The number of renewal times is not
limited.
For more information about auto-renewal rules,
see Auto-Renewal Rules.

Quantity 1 Set the number of FlexusL instances to be
purchased.

 
4. Click Buy Now.

On the displayed page, confirm the order details, read and select the
agreement, and click Submit.

5. Select a payment method and complete the payment.
6. Go back to the FlexusL console and view the purchased FlexusL instance.

Step 2: Configure a Security Group
Add inbound security group rules to ensure that the application preinstalled in the
image can be accessed.

1. Log in to the console and click a resource card to go to the instance details
page.

Huawei Cloud Flexus
Best Practices

9 Using PrestaShop to Build an E-Commerce
Website

Issue 02 (2024-06-04) Copyright © Huawei Cloud Computing Technologies Co., Ltd. 88

https://support.huaweicloud.com/intl/en-us/usermanual-billing/renewals_topic_20000002.html
https://console-intl.huaweicloud.com/smb/?&locale=en-us#/resource/list


2. In the navigation pane on the left, choose Cloud Servers and then click the
server name.

3. On the Security Groups tab, click Add Rule. In the displayed dialog box, add
rules displayed in the following figure and click OK.
The following figure only displays common rules. You can add more rules as
needed.

Table 9-1 Security group rules

Prior
ity

Acti
on

Type Protocol
& Port

Source Description

100 Allo
w

IPv4 TCP: 3306 0.0.0.0/0 Allows access to MySQL
databases.

100 Allo
w

IPv4 TCP: 9001 0.0.0.0/0 Allows external access to
the application
management page.

100 Allo
w

IPv4 TCP: 9000 0.0.0.0/0 Allows external access to
the application O&M
dashboard.

 

(Optional) Step 3: Add and Resolve a Domain Name
Add and resolve a domain name for the server so that users can use the domain
name to access the website. If the website is only used for personal development
or testing, there is no need to add a domain name.

1. In the navigation pane on the left, choose Cloud Servers. Locate the server
and click its name.

2. On the Server Details page, click the Domain Names tab and click Add
Domain Name.
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Parameter Setting

Domain Name Enter a domain name that will be added for the instance,
for example, wpwebsite.com.
NOTE

A domain name that is not registered can be added. After the
domain name is added, it must be registered and licensed. To
ensure that a domain name can be used normally, register the
domain name and complete ICP licensing before adding the
domain name.

Enterprise
Project

Select an enterprise project from the drop-down list.
Enterprise projects are associated with public zones. You
can manage public zones by enterprise project.
NOTE

This parameter is displayed only when your account is an
enterprise account.

 
3. Click OK.
4. In the row containing the wpwebsite.com domain name, click Configure

Record Set.

Parameter Setting

Domain
Name Prefix

If you enter a prefix, a subdomain is used for website access.
Either the domain name or its subdomains can be resolved
to the EIP of the instance.
Suppose the domain name is wpwebsite.com.
● If the domain name prefix is left empty, wpwebsite.com is

resolved to the EIP.
● If the domain name prefix is www, the subdomain

www.wpwebsite.com is mapped to the EIP.

EIP The EIP bound to the instance is displayed here
automatically.

 
5. On the Domain Names tab, view the domain name resolution details.
6. Apply for ICP licensing for the domain name.
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To successfully access the server using a domain name, you must file the
domain name. Domain name filing in the Huawei Cloud ICP license center is
free of charge. For details, see ICP Filing Process.

9.3 Initializing PrestaShop
The image application dashboard needs to be initialized only when you log in for
the first time.

NO TICE

When you visit http://Public IP address:9001/admin to access the management
console for the first time, PrestaShop generates a random character string
following admin for encryption. Keep the encrypted address in mind because you
can only use it to access the management console. For example, when you visit
http://1.1.1.1:9001/admin to access the management console for the first time,
the address automatically changes to http://1.1.1.1:9001/admin923reep1k.
You can also reset the address for accessing the management console, but this will
lead to data loss. Please keep the encrypted address safe.

1. Obtain the administrator username and password for logging in to
PrestaShop.

a. In the address bar of a local browser, enter http://EIP:9000 to log in to
the application O&M dashboard.
The username and password for logging in to the dashboard are the root
user and password of the FlexusL instance. A FlexusL instance does not
have an initial password. Reset the password and use it to log in to the
dashboard.

b. Choose My Apps and click the App icon.
c. Choose Access and click Initial Account to view the username and

password of the administrator.

2. Visit http://Public IP address:9001/admin in the address bar of a local
browser to access the management console.
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NO TICE

When you visit http://Public IP address:9001/admin to access the
management console for the first time, PrestaShop generates a random
character string following admin for encryption. Keep the encrypted address
in mind because you can only use it to access the management console. For
example, when you visit http://1.1.1.1:9001/admin to access the
management console for the first time, the address automatically changes to
http://1.1.1.1:9001/admin923reep1k.
You can also reset the address for accessing the management console, but
this will lead to data loss. Please keep the encrypted address safe.

3. Enter the password obtained in step 1.

4. Click LOG IN to log in to PrestaShop.
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Then, you have obtained a PrestaShop hosting server. You can start operating the
website or follow the steps in Deploying PrestaShop to manage language
packages and set languages, install modules, back up databases, and configure
domain names.

9.4 Deploying PrestaShop

Managing Language Packages and Setting Languages
PrestaShop has a built-in multi-language system. You only need to select the
corresponding language and import it to your PrestaShop system online.

● Import a language package.

a. Choose IMPROVE > International > Localization, select the language
package you want to import, and click Import.

b. Click the Languages tab to view the language packages that have been
imported.

● Set the language of the dashboard.
Click the avatar on the right corner, select Your profile and set the language.
Click Save.
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● Delete a language package.

You can delete unnecessary language packages.

a. Choose International > Localization > Languages and disable the
language package you want to delete.

b. In the Actions list, click Delete to delete the language that is disabled.

Managing Modules

PrestaShop has a rich module library, which greatly expands the functions of
PrestaShop.

● Choose Modules > Marketplace, find the required plug-in, and click Buy
Now or Install to purchase and install the module.

You can also click Upload a module to install other modules.

● Choose Modules > Module Manager.

– On the Modules tab page, you can disable, configure, uninstall, and
restore the modules.
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– On the Alerts tab page, you can view the notifications of modules.
– On the Updates tab page, you can view modules that can be updated.

Backing Up Databases
PrestaShop allows you to back up databases.

1. In the navigation pane on the left, choose Advanced Parameters > Database
> DB Backup, read the disclaimer, and click I have read the disclaimer.
Please create a new backup.
You can follow the instructions on the following page to restore a database.

2. Click Download the backup file to download the backup file to your local
PC.

Configuring Domain Names
After a domain name is added and resolved, you need to configure the domain
name on PrestaShop so that your users can use the domain name to access
PrestaShop.

1. Choose Shop Parameters > General > Maintenance and set Enable Shop to
Yes.

2. Choose Shop Parameters > Traffic & SEO. On the Set shop URL area of SEO
& URLs page, set the Shop domain and SSL domain. The values must be the
same as those of the server domain name.
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3. Click Save.
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10 Using Odoo to Build an ERP System

10.1 Overview

Applicable Scenario
Odoo is an open-source ERP/CRM software that integrates a comprehensive suite
of applications for managing all aspects of your business, including procurement,
inventory, finance and accounting, marketing, manufacturing, human resources
management, service support, e-commerce, and website building, achieving fully
automated service processes. The Odoo application image uses Ubuntu 22.04 and
is deployed using Docker. The Nginx, pgAdmin, and Docker have been
preconfigured in the image. This section describes how to use Odoo to build an
ERP system.

Resource Planning and Costs
This practice uses the following resource planning as an example. You can adjust it
as required.

Resource Configuration Description

Cloud server ● vCPUs: 2
● Memory: 2 GiB

Select appropriate instance
specifications based on your service
requirements.

Image Odoo Select the Odoo application image.

Security group Inbound rule:
● Protocol/

Application: TCP
● Port: 9001
● Source: 0.0.0.0/0

9001: Allows external access to the
application management page.
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Resource Configuration Description

Domain name wpwebsite.com ● If the website is only used for
personal development or testing,
there is no need to add a domain
name.

● If the website is open to the public,
add and resolve a domain name
for the cloud server.

 

Process
Step Procedure Description

1 Purchasing and
Configuring a
FlexusL
Instance

Purchase and deploy a FlexusL instance, configure
security groups, and configure domain names.

2 Initializing
Odoo

Log in to Odoo and create databases.

3 Deploying
Odoo

On the dashboard, perform the following operations:
● Configure general settings.
● Obtain administrator information and technical

support.
● Manage databases.

 

10.2 Purchasing and Configuring a FlexusL Instance
This section describes how to purchase and configure a FlexusL instance, including
purchasing a cloud server, setting the server login password, logging in to the
server, configuring a security group, and adding and resolving a domain name.

Procedure
Procedure Description

Step 1: Purchase a
FlexusL Instance

Purchase a FlexusL instance and select the Odoo
application image.

Step 2: Configure a
Security Group

Add inbound security group rules to ensure that the
application preinstalled in the image can be accessed.

(Optional) Step 3:
Add and Resolve a
Domain Name

Add and resolve a domain name for the server so that
users can use the domain name to access the website. If
the website is only used for personal development or
testing, there is no need to add a domain name.
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Step 1: Purchase a FlexusL Instance
1. Log in to the FlexusL console.
2. Click Buy FlexusL.
3. Specify required parameters for the FlexusL instance.

Paramet
er

Example Description

Region CN-Hong
Kong

For low network latency and quick resource
access, select the region nearest to your target
users. After a FlexusL instance is created, the
region cannot be changed. Exercise caution when
selecting a region.

Applicati
on
Images

Odoo Select the Odoo application image.

Instance
Specificat
ions

2 vCPUs | 2
GiB
memory
and 60 GiB
system disk

Select instance specifications as needed.

(Optional
) Instance
Name

Odoo-
Example

Customize an instance name that is easy to
identify, for example, Odoo-Example.
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Paramet
er

Example Description

(Optional
)
Associate
d Services

● Data
disk: 10
GiB

● Host
security

● Cloud
backup
vault: 70
GiB

You can bundle any of the services to your
FlexusL instances as needed: EVS, HSS (basic
edition), and CBR and set specifications as
needed.

Required
Duration

1 month The minimum duration of a purchase is one
month and the maximum duration is three years.
Auto-renew is enabled by default, which means
the purchased FlexusL instances will be
automatically renewed before they expire. If you
do not enable auto-renew during the purchase
process, you can still enable it later after the
instances are created. Monthly subscription
allows you to renew the subscription for one
month every time. The number of renewal times
is not limited.
For more information about auto-renewal rules,
see Auto-Renewal Rules.

Quantity 1 Set the number of FlexusL instances to be
purchased.

 
4. Click Buy Now.

On the displayed page, confirm the order details, read and select the
agreement, and click Submit.

5. Select a payment method and complete the payment.
6. Go back to the FlexusL console and view the purchased FlexusL instance.

Step 2: Configure a Security Group
Add inbound security group rules to ensure that the application preinstalled in the
image can be accessed.

1. Log in to the console and click a resource card to go to the instance details
page.

2. In the navigation pane on the left, choose Cloud Servers and then click the
server name.
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3. On the Security Groups tab, click Add Rule. In the displayed dialog box, add
rules displayed in the following figure and click OK.

The following figure only displays common rules. You can add more rules as
needed.

Table 10-1 Security group rules

Priorit
y

Actio
n

Type Protocol
& Port

Source Description

100 Allow IPv4 TCP:
9001

0.0.0.0/0 Allows external access to
the application
management page.

 

(Optional) Step 3: Add and Resolve a Domain Name

Add and resolve a domain name for the server so that users can use the domain
name to access the website. If the website is only used for personal development
or testing, there is no need to add a domain name.

1. In the navigation pane on the left, choose Cloud Servers. Locate the server
and click its name.

2. On the Server Details page, click the Domain Names tab and click Add
Domain Name.

Parameter Setting

Domain Name Enter a domain name that will be added for the instance,
for example, wpwebsite.com.
NOTE

A domain name that is not registered can be added. After the
domain name is added, it must be registered and licensed. To
ensure that a domain name can be used normally, register the
domain name and complete ICP licensing before adding the
domain name.
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Parameter Setting

Enterprise
Project

Select an enterprise project from the drop-down list.
Enterprise projects are associated with public zones. You
can manage public zones by enterprise project.
NOTE

This parameter is displayed only when your account is an
enterprise account.

 

3. Click OK.

4. In the row containing the wpwebsite.com domain name, click Configure
Record Set.

Parameter Setting

Domain
Name Prefix

If you enter a prefix, a subdomain is used for website access.
Either the domain name or its subdomains can be resolved
to the EIP of the instance.
Suppose the domain name is wpwebsite.com.
● If the domain name prefix is left empty, wpwebsite.com is

resolved to the EIP.
● If the domain name prefix is www, the subdomain

www.wpwebsite.com is mapped to the EIP.

EIP The EIP bound to the instance is displayed here
automatically.

 

5. On the Domain Names tab, view the domain name resolution details.

6. Apply for ICP licensing for the domain name.

To successfully access the server using a domain name, you must file the
domain name. Domain name filing in the Huawei Cloud ICP license center is
free of charge. For details, see ICP Filing Process.

10.3 Initializing Odoo
The image application dashboard needs to be initialized only when you log in for
the first time.
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1. On the Overview page, click Access in the Dashboard field in the Image
area.

2. Configure the parameters and click Create database.
If you have had a backup database on your local device, click or restore a
database.
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Table 10-2 Parameter descriptions

Parameter Description

Master
Password

The system automatically generates a database master
password. You can change it but be sure to remember it.
NOTE

The database master password will be asked for future
operations on databases, so please keep it safe.

Database
Name

Specifies a database name.

Email/
Password

Specifies the email address and password for the
administrator to log in to Odoo. Please keep it safe.

Phone number Specifies the telephone number of the administrator.

Language Specifies the language you want to use on the
management console.

Country Specifies the country or region where you are located.

Demo data After this option is selected, data samples are
automatically generated for the created database.

 

3. Enter the email address and password, and click Log in.
The management console is displayed.

Then, you have obtained an Odoo hosting server. You can start using Odoo or
follow the steps in Deploying Odoo to configure general settings, obtain
administrator information and technical support, and manage databases.

10.4 Deploying Odoo

General Settings

1. Click  in the upper left corner and choose Settings.
2. Add a user.

a. Click New in the upper left corner.
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b. After the user is added, click the username to view or modify the
username, email address, access permissions, and preferences.
The email address must be unique. If you enter a name that already
exists, the message indicating the operation cannot be completed
because you cannot have two users with the same login will be displayed.

3. Add a company.

a. Choose User & Companies > Companies, click New, and enter the
company name and general information.

b. Click New in the upper right corner.
After the company is added, you can click the company name to view or
modify the basic information about the company.

Obtaining Administrator Information and Technical Support
Click the administrator avatar in the upper right corner.

● Click Documentation to obtain the official Odoo guide.
● Click Support to go to the Odoo official website and learn more about Odoo

products.
● Press Shortcuts CTRL+K to set the shortcut key.
● Click Preferences and set administrator preferences and account security

information.
● Click My Odoo.com account to go to the Odoo login page.

Managing Databases
On the Odoo login page, click Manage Databases to access the Odoo database
manager.
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NO TE

You can access the Odoo login page:
● From the FlexusL management console. For details, see 1.
● By selecting the administrator avatar in the upper right corner and clicking Log out, if

you have logged in to Odoo.

● (Optional) Set Master Password
If you did not change the database master password when initialing Odoo in
2, you can reset a master password that is easy to remember. The master
password is required when you create, delete, dump, or restore databases.
Please keep it safe.

a. Click Set Master Password to set a new master password.

b. Click Continue to save the new master password.
● Create Database

You can add multiple companies on Odoo. Each database means a company.
Multiple companies can use Odoo with different accounts and do not
interfere with each other.

a. Click Create Database and set basic information.
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b. Click Continue.
c. Click Select, select Database2, and enter the email and password.
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d. Click Log in to log in to the management page of Database2.
● Backup Database

a. On the database management page, click Backup.
b. On the Backup Database page, enter the master password, select a

backup format, and click Backup.
After the backup is completed, the system will automatically download
the database backup file.
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● Duplicate Database
The data of a company can be duplicated and used as the data of a new
enterprise.

a. On the database management page, click Duplicate.
b. Enter the master password, set a new database name, and click

Continue.
After the duplication is successful, the duplicated database will be
displayed in the database management column.

● Restore Database
After a database is deleted, it can be restored using backup data.

a. Click Restore Database.
b. Enter the master password, select the backup file, set the database name,

and click Continue.
After the restoration is successful, the restored database will be displayed
in the database management column.
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11 Using Superset to Obtain Data from
MySQL Databases for Analysis

11.1 Overview

Applicable Scenario

Superset is an open-source data exploration and visualization platform. This tool
provides a quick way to intuitively visualize datasets by allowing you to create and
share interactive dashboards. The Superset application image uses Ubuntu 22.04
and is deployed using Docker. The Nginx, Redis, pgAdmin, and Docker have been
preconfigured in the image. This section describes how to use Superset to obtain
data from MySQL databases for analysis.

Resource Planning and Costs

This practice uses the following resource planning as an example. You can adjust it
as required.

Resource Configuration Description

Cloud server vCPUs: 2
Memory: 8 GiB

A Superset application image requires
at least 2 vCPUs and 8 GiB memory.
Select appropriate instance
specifications accordingly.

Image Superset Select the Superset application image.

Security group Inbound rule:
● Protocol/

Application: TCP
● Port:

9001,9000,3306
● Source: 0.0.0.0/0

● 9001: Allows external access to the
application management page.

● 9000: Allows external access to the
dashboard of the application
preinstalled in the image.

● 3306: Allows access to MySQL
databases.
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Resource Configuration Description

Domain name wpwebsite.com ● If the website is only used for
personal development or testing,
there is no need to add a domain
name.

● If the website is open to the public,
add and resolve a domain name
for the cloud server.

 

Process
Step Procedure Description

1 Purchasing and
Configuring a
FlexusL
Instance

Purchase and configure a FlexusL instance.

2 Initializing
Superset

Set the language, log in to Superset, and reset the
password.

3 Obtaining Data
from MySQL
Databases for
Analysis

To use Superset to obtain data from MySQL
databases for analysis, you need to connect to a
database, add datasets, and create charts.

 

11.2 Purchasing and Configuring a FlexusL Instance
This section describes how to purchase and configure a FlexusL instance, including
purchasing a cloud server, setting the server login password, logging in to the
server, configuring a security group, and adding and resolving a domain name.

Procedure
Procedure Description

Step 1: Purchase a
FlexusL Instance

Purchase a FlexusL instance and select the Superset
application image.

Step 2: Configure a
Security Group

Add inbound security group rules to ensure that the
application preinstalled in the image can be accessed.

(Optional) Step 3:
Add and Resolve a
Domain Name

Add and resolve a domain name for the server so that
users can use the domain name to access the website. If
the website is only used for personal development or
testing, there is no need to add a domain name.
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Step 1: Purchase a FlexusL Instance
1. Log in to the FlexusL console.
2. Click Buy FlexusL.
3. Specify required parameters for the FlexusL instance.

Paramet
er

Example Description

Region CN-Hong
Kong

For low network latency and quick resource
access, select the region nearest to your target
users. After a FlexusL instance is created, the
region cannot be changed. Exercise caution when
selecting a region.

Applicati
on
Images

Superset Select the Superset application image.

Instance
Specificat
ions

2 vCPUs | 8
GiB
memory

Select instance specifications as needed.

(Optional
) Instance
Name

Superset-
Example

Customize an instance name that is easy to
identify, for example, Superset-Example.
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Paramet
er

Example Description

(Optional
)
Associate
d Services

● Data
disk: 10
GiB

● Host
security

● Cloud
backup
vault:
170 GiB

You can bundle any of the services to your
FlexusL instances as needed: EVS, HSS (basic
edition), and CBR and set specifications as
needed.

Required
Duration

1 month The minimum duration of a purchase is one
month and the maximum duration is three years.
Auto-renew is enabled by default, which means
the purchased FlexusL instances will be
automatically renewed before they expire. If you
do not enable auto-renew during the purchase
process, you can still enable it later after the
instances are created. Monthly subscription allows
you to renew the subscription for one month
every time. The number of renewal times is not
limited.
For more information about auto-renewal rules,
see Auto-Renewal Rules.

Quantity 1 Set the number of FlexusL instances to be
purchased.

 
4. Click Buy Now.

On the displayed page, confirm the order details, read and select the
agreement, and click Submit.

5. Select a payment method and complete the payment.
6. Go back to the FlexusL console and view the purchased FlexusL instance.

Step 2: Configure a Security Group
Add inbound security group rules to ensure that the application preinstalled in the
image can be accessed.

1. Log in to the console and click a resource card to go to the instance details
page.

2. In the navigation pane on the left, choose Cloud Servers and then click the
server name.

Huawei Cloud Flexus
Best Practices

11 Using Superset to Obtain Data from MySQL
Databases for Analysis

Issue 02 (2024-06-04) Copyright © Huawei Cloud Computing Technologies Co., Ltd. 113

https://support.huaweicloud.com/intl/en-us/usermanual-billing/renewals_topic_20000002.html
https://console-intl.huaweicloud.com/smb/?&locale=en-us#/resource/list


3. On the Security Groups tab, click Add Rule. In the displayed dialog box, add
rules displayed in the following figure and click OK.
The following figure only displays common rules. You can add more rules as
needed.

Table 11-1 Security group rules

Prior
ity

Acti
on

Type Protocol
& Port

Source Description

100 Allo
w

IPv4 TCP: 3306 0.0.0.0/0 Allows access to MySQL
databases.

100 Allo
w

IPv4 TCP: 9001 0.0.0.0/0 Allows external access to
the application
management page.

100 Allo
w

IPv4 TCP: 9000 0.0.0.0/0 Allows external access to
the application O&M
dashboard.

 

(Optional) Step 3: Add and Resolve a Domain Name
Add and resolve a domain name for the server so that users can use the domain
name to access the website. If the website is only used for personal development
or testing, there is no need to add a domain name.

1. In the navigation pane on the left, choose Cloud Servers. Locate the server
and click its name.

2. On the Server Details page, click the Domain Names tab and click Add
Domain Name.
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Parameter Setting

Domain Name Enter a domain name that will be added for the instance,
for example, wpwebsite.com.
NOTE

A domain name that is not registered can be added. After the
domain name is added, it must be registered and licensed. To
ensure that a domain name can be used normally, register the
domain name and complete ICP licensing before adding the
domain name.

Enterprise
Project

Select an enterprise project from the drop-down list.
Enterprise projects are associated with public zones. You
can manage public zones by enterprise project.
NOTE

This parameter is displayed only when your account is an
enterprise account.

 
3. Click OK.
4. In the row containing the wpwebsite.com domain name, click Configure

Record Set.

Parameter Setting

Domain
Name Prefix

If you enter a prefix, a subdomain is used for website access.
Either the domain name or its subdomains can be resolved
to the EIP of the instance.
Suppose the domain name is wpwebsite.com.
● If the domain name prefix is left empty, wpwebsite.com is

resolved to the EIP.
● If the domain name prefix is www, the subdomain

www.wpwebsite.com is mapped to the EIP.

EIP The EIP bound to the instance is displayed here
automatically.

 
5. On the Domain Names tab, view the domain name resolution details.
6. Apply for ICP licensing for the domain name.
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To successfully access the server using a domain name, you must file the
domain name. Domain name filing in the Huawei Cloud ICP license center is
free of charge. For details, see ICP Filing Process.

11.3 Initializing Superset
The image application dashboard needs to be initialized only when you log in for
the first time.

1. Obtain the administrator username and password for logging in to Superset.

a. In the address bar of a local browser, enter http://EIP:9000 to log in to
the application O&M dashboard.
The username and password for logging in to the dashboard are the root
user and password of the FlexusL instance. A FlexusL instance does not
have an initial password. Reset the password and use it to log in to the
dashboard.

b. Choose My Apps and click the App icon.
c. Choose Access and click Initial Account to view the username and

password of the administrator.

2. On the Overview page, click Access in the Dashboard field in the Image
area.

3. Enter the username and password obtained in step 1 to access the
management page.
You can set the language on the login page or on the management page.
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4. In the upper right corner of the page, choose Settings > User > Info and click
RESET MY PASSWORD.

Preset passwords are usually difficult to remember, so you are advised to set a
password that is easy to remember, and please keep it safe.

Then, you have obtained a Superset hosting server. You can start using Superset or
follow the steps in Obtaining Data from MySQL Databases for Analysis to
connect to a database, add datasets, and create charts.

11.4 Obtaining Data from MySQL Databases for
Analysis

Connecting to Database

You can only analyze data after connecting to a database first.

1. On the management page, choose Data > Databases and click +DATABASE.
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2. Select the database to be connected, for example, the MySQL database.
3. Enter the information about the database to be connected.

Table 11-2 Parameter descriptions

Parameter Description

HOST/PORT Specifies the public IP address and port number of the
database. The default MySQL port number is 3306.

DATABASE
NAME

Specifies the name of the database to be connected.

USERNAME/
PASSWORD

Specifies the username and password of the database.

DISPLAY
NAME

Specifies the name displayed on Superset after the database
is connected.
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4. Click CONNECT.

5. Click FINISH and you can view the connected database in the list.

Adding Datasets

Now that you have configured a data source, you need to register tables (called
Datasets in Superset) for subsequent chart creation.

1. Choose Data > Datasets and click +DATASET.

2. Click ADD, and you can view your dataset in the list of datasets.

Creating Charts

Superset is a powerful visualization builder that allows you to create charts and
dashboards. This section is for demonstration only. You can create exquisite charts
and dashboards by referring to the official guide.

1. Click the database name to visualize the chart.

2. Click SAVE to add the chart to the dashboard.
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3. Click SAVE & GO TO DASHBOARD. The visualized chart is displayed on the
dashboard.
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12 Using Nextcloud to Build an
Enterprise Web Disk System

12.1 Overview

Applicable Scenario
Nextcloud is a suite of open-source cloud based storage software for self-built
private cloud disks for enterprises. Nextcloud supports PC, Android, and iOS, and
you can easily synchronize with vital data stored on servers, including files,
schedules, contacts, and bookmarks. The Nextcloud image uses Ubuntu 22.04 and
is deployed using Docker. The Nginx, MySQL, phpMyAdmin, and Docker have been
preconfigured in the image. This section describes how to use Nextcloud to build
an enterprise web disk system.

Resource Planning and Costs
This practice uses the following resource planning as an example. You can adjust it
as required.

Resource Configuration Description

Cloud server ● vCPUs: 2
● Memory: 4 GiB

Select appropriate instance
specifications based on your service
requirements.

Image Nextcloud Select the Nextcloud application
image.
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Resource Configuration Description

Security group Inbound rule:
● Protocol & Port

TCP: 9001,9000
Source: 0.0.0.0/0

● Protocol & Port
ICMP: all
Source: 0.0.0.0/0

● 9001: Allows external access to the
application management page.

● 9000: Allows external access to the
dashboard of the application
preinstalled in the image.

Domain name wpwebsite.com ● If the website is only used for
personal development or testing,
there is no need to add a domain
name.

● If the website is open to the public,
add and resolve a domain name
for the cloud server.

 

Process
Step Procedure Description

1 Purchasing
and
Configuring a
FlexusL
Instance

Purchase a FlexusL instance, configure security
groups, and configure domain names.

3 Initializing
Nextcloud

Log in to the frontend page and install Nextcloud.

4 Deploying
Nextcloud

On the dashboard, perform the following operations:
● Install applications.
● Configure SMTP.
● Configure domain names.

 

12.2 Purchasing and Configuring a FlexusL Instance
This section describes how to purchase and configure a FlexusL instance, including
purchasing a cloud server, setting the server login password, logging in to the
server, configuring a security group, and adding and resolving a domain name.
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Procedure
Procedure Description

Step 1: Purchase a
FlexusL Instance

Purchase a FlexusL instance and select the Nextcloud
application image.

Step 2: Configure a
Security Group

Add inbound security group rules to ensure that the
application preinstalled in the image can be accessed.

(Optional) Step 3:
Add and Resolve a
Domain Name

Add and resolve a domain name for the server so that
users can use the domain name to access the website. If
the website is only used for personal development or
testing, there is no need to add a domain name.

 

Step 1: Purchase a FlexusL Instance
1. Log in to the FlexusL console.
2. Click Buy FlexusL.
3. Specify required parameters for the FlexusL instance.

Paramet
er

Example Description

Region CN-Hong
Kong

For low network latency and quick resource access,
select the region nearest to your target users. After
a FlexusL instance is created, the region cannot be
changed. Exercise caution when selecting a region.
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Paramet
er

Example Description

Applicati
on
Images

Nextclou
d

Select the Nextcloud application image.

Instance
Specificat
ions

2 vCPUs |
4 GiB
memory
and 80
GiB
system
disk

Select instance specifications as needed.

Instance
Name

Nextclou
d-
Example

Customize an instance name that is easy to identify,
for example, Nextcloud-Example.

(Optional
)
Associate
d
Services

● Data
disk:
10 GiB

● Host
securit
y

● Cloud
backu
p
vault:
90 GiB

You can bundle any of the services to your FlexusL
instances as needed: EVS, HSS (basic edition), and
CBR and set specifications as needed.

Required
Duration

1 month The minimum duration of a purchase is one month
and the maximum duration is three years.
Auto-renew is enabled by default, which means the
purchased FlexusL instances will be automatically
renewed before they expire. If you do not enable
auto-renew during the purchase process, you can
still enable it later after the instances are created.
Monthly subscription allows you to renew the
subscription for one month every time. The number
of renewal times is not limited.
For more information about auto-renewal rules, see
Auto-Renewal Rules.

Quantity 1 Set the number of FlexusL instances to be
purchased.

 
4. Click Buy Now.

On the displayed page, confirm the order details, read and select the
agreement, and click Submit.

5. Select a payment method and complete the payment.
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6. Go back to the FlexusL console and view the purchased FlexusL instance.

Step 2: Configure a Security Group
Add inbound security group rules to ensure that the application preinstalled in the
image can be accessed.

1. Log in to the console and click a resource card to go to the instance details
page.

2. In the navigation pane on the left, choose Cloud Servers and then click the
server name.

3. On the Security Groups tab, click Add Rule. In the displayed dialog box, add
rules displayed in the following figure and click OK.
The following figure only displays common rules. You can add more rules as
needed.

Table 12-1 Security group rules

Priorit
y

Actio
n

Type Protocol
& Port

Source Description

100 Allow IPv4 TCP:
9001

0.0.0.0/0 Allows external access to
the application
management page.

100 Allow IPv4 TCP:
9000

0.0.0.0/0 Allows external access to
the application O&M
dashboard.

 

(Optional) Step 3: Add and Resolve a Domain Name
Add and resolve a domain name for the server so that users can use the domain
name to access the website. If the website is only used for personal development
or testing, there is no need to add a domain name.

1. In the navigation pane on the left, choose Cloud Servers. Locate the server
and click its name.
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2. On the Server Details page, click the Domain Names tab and click Add
Domain Name.

Parameter Setting

Domain Name Enter a domain name that will be added for the instance,
for example, wpwebsite.com.
NOTE

A domain name that is not registered can be added. After the
domain name is added, it must be registered and licensed. To
ensure that a domain name can be used normally, register the
domain name and complete ICP licensing before adding the
domain name.

Enterprise
Project

Select an enterprise project from the drop-down list.
Enterprise projects are associated with public zones. You
can manage public zones by enterprise project.
NOTE

This parameter is displayed only when your account is an
enterprise account.

 

3. Click OK.

4. In the row containing the wpwebsite.com domain name, click Configure
Record Set.

Parameter Setting

Domain
Name Prefix

If you enter a prefix, a subdomain is used for website access.
Either the domain name or its subdomains can be resolved
to the EIP of the instance.
Suppose the domain name is wpwebsite.com.
● If the domain name prefix is left empty, wpwebsite.com is

resolved to the EIP.
● If the domain name prefix is www, the subdomain

www.wpwebsite.com is mapped to the EIP.

EIP The EIP bound to the instance is displayed here
automatically.

 

5. On the Domain Names tab, view the domain name resolution details.
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6. Apply for ICP licensing for the domain name.
To successfully access the server using a domain name, you must file the
domain name. Domain name filing in the Huawei Cloud ICP license center is
free of charge. For details, see ICP Filing Process.

12.3 Initializing Nextcloud
The image application dashboard needs to be initialized only when you log in for
the first time.

1. Obtain the administrator username and password for logging in to Nextcloud.

a. In the address bar of a local browser, enter http://EIP:9000 to log in to
the application O&M dashboard.
The username and password for logging in to the dashboard are the root
user and password of the FlexusL instance. A FlexusL instance does not
have an initial password. Reset the password and use it to log in to the
dashboard.

b. Choose My Apps and click the App icon.
c. Choose Access and click Initial Account to view the username and

password of the administrator.

2. On the Overview page, click Access in the Dashboard field in the Image
area.

3. Set the username and password of the Nextcloud administrator and click Log
in.

4. After the installation is complete, you can continue to install recommended
applications as prompted or click Cancel.
You can still install these applications on the management page subsequently.
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5. You can go through the pop-ups to learn about the Nextcloud functions, and
then configure Nextcloud on the management page.

Then, you have obtained a Nextcloud hosting server. You can start using
Nextcloud or follow the steps in Deploying Nextcloud to install applications,
configure SMTP, and configure domain names.

12.4 Deploying Nextcloud

Installing Applications
Nextcloud integrates various applications, and you can add more functions to
Nextcloud by installing these applications.

1. Click  in the upper right corner and choose Apps to view the applications
integrated with Nextcloud.

2. Click Enable.

Configuring SMTP
Configuring an SMTP mail server in an application is very important. It can be
used to get back your passwords and receive important notifications. You are
advised to configure the SMTP service to enable the email notification function.

1. Click  in the upper right corner and click Personal.
2. Enter the sender's email address, for example, example@163.

The email address must be available, and the SMTP function must have been
configured.

3. Choose Administration > Basic Settings > Email Server, and configure SMTP
information.
In this example, the 163 mailbox is only for reference. Please configure the
corresponding parameters when other mailboxes are used.
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Parameter Description

Send mode Select SMTP.

Encryption Select SSL/TLS.

From address Enter an email address, for example, example@163.com.

Server address Enter smtp.163.com for the 163 email server.

Port number Enter 465.

Authentication
method

Select Authentication required.

Credentials ● SMTP Username: Set it to the email address.
● SMTP Password: Set it to the authorization code

obtained when configuring SMTP for
example@163.com rather than the login password of
example@163.com.

 
4. Click Store credentials.
5. Click Send email to test whether the SMTP has been successfully configured.
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13 Pushing PC Desktop Streams to SRS
Using OBS

13.1 Overview

Applicable Scenario
SRS is a simple and an efficient real-time video server that supports various real-
time streaming media protocols, such as RTMP, WebRTC, HLS, HTTP-FLV, and SRT.
The SRS image uses Ubuntu 22.04 and is deployed using Docker. The Nginx and
Docker have been preconfigured in the image. This section describes how to push
PC desktop streams to SRS using OBS.

Resource Planning and Costs
This practice uses the following resource planning as an example. You can adjust it
as required.

Resource Configuration Description

Cloud server ● vCPUs: 2
● Memory: 4 GiB

Select appropriate instance
specifications based on your service
requirements.

Image SRS Select the SRS application image.
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Resource Configuration Description

Security group Inbound rule:
● Protocol & Port

TCP:
9001,1935,1985,808
0,8000
Source: 0.0.0.0/0

● Protocol & Port
ICMP: all
Source: 0.0.0.0/0

● 9001: Allows external access to the
application management page.

● 1935: Allows access to the RTMP
livestreaming server.

● 1985: Allows access to the HTTP
API server to deliver HTTP-API and
WebRTC streams.

● 8080: Allows access to the HTTP
livestreaming server to deliver
HTTP-FLV and HLS streams.

● 8000: Allows access to the WebRTC
media server.

Domain name wpwebsite.com ● If the website is only used for
personal development or testing,
there is no need to add a domain
name.

● If the website is open to the public,
add and resolve a domain name
for the cloud server.

 

Process
Step Procedure Description

1 Purchasing and
Configuring a
FlexusL
Instance

Purchase and configure a FlexusL instance.

2 Learning About
the SRS
Working
Interface

Understand the SRS working interface.

3 Pushing Local
PC Desktop
Streams to SRS
Using OBS

Learn how to push local PC desktop streams to SRS
using OBS.

 

13.2 Purchasing and Configuring a FlexusL Instance
This section describes how to purchase and configure a FlexusL instance, including
purchasing a cloud server, setting the server login password, logging in to the
server, configuring a security group, and adding and resolving a domain name.
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Procedure

Procedure Description

Step 1: Purchase a
FlexusL Instance

Purchase a FlexusL instance and select the SRS
application image.

Step 2: Configure a
Security Group

Add inbound security group rules to ensure that the
application preinstalled in the image can be accessed.

(Optional) Step 3:
Add and Resolve a
Domain Name

Add and resolve a domain name for the server so that
users can use the domain name to access the website. If
the website is only used for personal development or
testing, there is no need to add a domain name.

 

Step 1: Purchase a FlexusL Instance
1. Log in to the FlexusL console.

2. Click Buy FlexusL.

3. Specify required parameters for the FlexusL instance.

Paramet
er

Exampl
e

Description

Region CN-
Hong
Kong

For low network latency and quick resource access,
select the region nearest to your target users. After a
FlexusL instance is created, the region cannot be
changed. Exercise caution when selecting a region.

Applicati
on
Images

SRS Select the SRS application image.
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Paramet
er

Exampl
e

Description

Instance
Specificat
ions

2 vCPUs
| 4 GiB
memory
and 80
GiB
system
disk

Select instance specifications as needed.

(Optional
) Instance
Name

SRS-
Example

Customize an instance name that is easy to identify,
for example, SRS-Example.

(Optional
)
Associate
d Services

● Data
disk:
10
GiB

● Host
securi
ty

● Cloud
back
up
vault:
90
GiB

You can bundle any of the services to your FlexusL
instances as needed: EVS, HSS (basic edition), and
CBR and set specifications as needed.

Required
Duration

1 month The minimum duration of a purchase is one month
and the maximum duration is three years.
Auto-renew is enabled by default, which means the
purchased FlexusL instances will be automatically
renewed before they expire. If you do not enable
auto-renew during the purchase process, you can
still enable it later after the instances are created.
Monthly subscription allows you to renew the
subscription for one month every time. The number
of renewal times is not limited.
For more information about auto-renewal rules, see
Auto-Renewal Rules.

Quantity 1 Set the number of FlexusL instances to be
purchased.

 
4. Click Buy Now.

On the displayed page, confirm the order details, read and select the
agreement, and click Submit.

5. Select a payment method and complete the payment.
6. Go back to the FlexusL console and view the purchased FlexusL instance.
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Step 2: Configure a Security Group

Add inbound security group rules to ensure that the application preinstalled in the
image can be accessed.

1. Log in to the console and click a resource card to go to the instance details
page.

2. In the navigation pane on the left, choose Cloud Servers and then click the
server name.

3. On the Security Groups tab, click Add Rule. In the displayed dialog box, add
rules displayed in the following figure and click OK.

The following figure only displays common rules. You can add more rules as
needed.

Table 13-1 Security group rules

Prio
rity

Acti
on

Typ
e

Protoc
ol &
Port

Sour
ce

Description

100 Allo
w

IPv
4

TCP:
9001

0.0.0.
0/0

Allows external access to the
application management page.

100 Allo
w

IPv
4

TCP:
1935

0.0.0.
0/0

Allows access to the RTMP
livestreaming server.

100 Allo
w

IPv
4

TCP:
1985

0.0.0.
0/0

Allows access to the HTTP API server
to deliver HTTP-API and WebRTC
streams.

100 Allo
w

IPv
4

TCP:
8080

0.0.0.
0/0

Allows access to the HTTP
livestreaming server to deliver HTTP-
FLV and HLS streams.

100 Allo
w

IPv
4

TCP:
8000

0.0.0.
0/0

Allows access to the WebRTC media
server.
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(Optional) Step 3: Add and Resolve a Domain Name
Add and resolve a domain name for the server so that users can use the domain
name to access the website. If the website is only used for personal development
or testing, there is no need to add a domain name.

1. In the navigation pane on the left, choose Cloud Servers. Locate the server
and click its name.

2. On the Server Details page, click the Domain Names tab and click Add
Domain Name.

Parameter Setting

Domain Name Enter a domain name that will be added for the instance,
for example, wpwebsite.com.
NOTE

A domain name that is not registered can be added. After the
domain name is added, it must be registered and licensed. To
ensure that a domain name can be used normally, register the
domain name and complete ICP licensing before adding the
domain name.

Enterprise
Project

Select an enterprise project from the drop-down list.
Enterprise projects are associated with public zones. You
can manage public zones by enterprise project.
NOTE

This parameter is displayed only when your account is an
enterprise account.

 
3. Click OK.
4. In the row containing the wpwebsite.com domain name, click Configure

Record Set.
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Parameter Setting

Domain
Name Prefix

If you enter a prefix, a subdomain is used for website access.
Either the domain name or its subdomains can be resolved
to the EIP of the instance.
Suppose the domain name is wpwebsite.com.
● If the domain name prefix is left empty, wpwebsite.com is

resolved to the EIP.
● If the domain name prefix is www, the subdomain

www.wpwebsite.com is mapped to the EIP.

EIP The EIP bound to the instance is displayed here
automatically.

 
5. On the Domain Names tab, view the domain name resolution details.
6. Apply for ICP licensing for the domain name.

To successfully access the server using a domain name, you must file the
domain name. Domain name filing in the Huawei Cloud ICP license center is
free of charge. For details, see ICP Filing Process.

13.3 Learning About the SRS Working Interface
1. On the Overview page, click Access in the Dashboard field in the Image

area.

2. Understand the SRS working interface.
You do not need to set the username and password for logging in to SRS. On
the SRS working interface, you can:
– Log in to the SRS console.
– Obtain the ingest URL.
– Start SRS player to watch the livestreaming content.
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Then, you have obtained an SRS hosting server. You can start using SRS or follow
the steps in Pushing Local PC Desktop Streams to SRS Using OBS to push and
watch livestreams.

13.4 Pushing Local PC Desktop Streams to SRS Using
OBS

This section describes how to push local PC desktop streams to SRS using OBS.

Pushing Livestreams
1. Download and install OBS based on your operating system.

2. Open OBS tool and click Settings in the Controls area.
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3. On the Stream page, configure parameters and click Apply.

Parameter Description

Service Multiple platforms can push livestreams via OBS. For SRS,
select Custom.

Server Enter the stream pushing address specified by SRS, for
example, rtmp://124.70.x.x/live/.

Stream key Specify a character string following the specified stream
pushing address, for example, the livestream following
live/ in rtmp://124.70.x.x/live/.

Use
authentication

Select Use authentication and set the Username and
Password.
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4. In the Output page, configure parameters and click Apply.
Set Video Bitrate to 1000 kbps. Select Software for Video Encoder to avoid
the need for high-end graphics cards and prevent potential streaming issues.
Configure other parameters as needed.

5. Click OK.
6. In the displayed Sources area, click +, select Display Capture, create a source,

and click OK.

7. Perform any operation to change the desktop screen, and you can see that
the screen starts to capture desktop content. Click OK.

8. Click Start Streaming. After the connection is successful, a green block is
displayed in the lower right corner, indicating that the stream pushing is
successful.

Watching Livestreams
1. Log in to the FlexusL console and click a resource card to go to the instance

details page.
2. On the Overview page, in the Image area, click Access to access the image

application dashboard.
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3. Start SRS player.

4. Watch the desktop livestreams.
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14 Change History

Released On Description

2024-06-04 This issue is the second official release.
Added the following:
● Managing Servers Using the BT Panel
● Using Superset to Obtain Data from MySQL

Databases for Analysis
● Pushing PC Desktop Streams to SRS Using OBS

2024-04-15 The issue is the first official release.
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